[image: image1.jpg]THE MEETING TRANSCRIPT OF
THE LOS ANGELES COUNTY
BOARD OF SUPERVISORS



[image: image2.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors




June 8, 2016

[image: image3.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors





          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 

            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to

       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There is no reportable action as a result of the

Board of Supervisors' closed session held today.]
HILDA SOLIS, CHAIR: GOOD MORNING, EVERYONE. THE LOS ANGELES COUNTY BOARD OF SUPERVISORS JUNE THE 8TH, 2016 MEETING WILL NOW COME TO ORDER. THE INVOCATION THIS MORNING WILL BE LED BY SAYED MAHDI AL-QAZWINI, ASSISTANT IMAM FROM THE ISLAMIC EDUCATIONAL CENTER OF ORANGE COUNTY, AND THE PLEDGE WILL BE LEAD THIS MORNING BY VICTOR CAMARENA, FORMER PETTY OFFICER, SECOND CLASS, UNITED STATES NAVY, LANCASTER. PLEASE RISE. 

SAYED MAHDI AL-QAZWINI: IN THE NAME OF GOD, THE MOST COMPASSIONATE, THE MOST MERCIFUL, I'D LIKE TO BEGIN BY THANKING THE BOARD OF SUPERVISORS AND ESPECIALLY SUPERVISOR HILDA SOLIS FOR GRACIOUSLY EXTENDING THE INVITATION TO ME TO LEAD THIS MORNING'S INVOCATION. PLEASE JOIN ME IN PRAYER. OH, OUR LORD, YOU ARE THE SOURCE OF ALL STRENGTH, MERCY AND WISDOM. BLESS OUR GATHERING HERE AS WE COME TOGETHER TO FIND WAYS IN WHICH TO SERVE YOU AND YOUR CREATION. OUR LORD, WE THANK YOU FOR ALL OF YOUR GREAT BLESSINGS UPON US. YOU HAVE BLESSED US TO BE CITIZENS AND RESIDENTS OF A BEAUTIFUL NATION, ONE THAT PRIDES ITSELF ON DEMOCRACY, JUSTICE, LIBERTY, FREEDOM, AND PLURALISM. WE PRAY THAT YOU CONTINUE TO BLESS THIS GREAT NATION WITH YOUR INNUMERABLE FAVORS. OUR LORD, YOU HAVE GIFTED OUR BELOVED NATION WITH STRENGTH AND LEADERSHIP IN THE WORLD. ALLOW US TO CONTINUE TO BE A SOURCE OF PEACE, SECURITY, GOODNESS AND RIGHTEOUSNESS IN THE WORLD AND TO AVOID ANY AND ALL FORMS OF INJUSTICE, OPPRESSION, INTOLERANCE, AND EVIL. OUR LORD, WE BESEECH YOU TO GRANT US THE STRENGTH TO EMPLOY EVERY RESOURCE THAT YOU HAVE BESTOWED UPON US TO BECOME AGENTS OF POSITIVE CHANGE IN OUR LIVES AND THE LIVES OF OTHERS AROUND US. OUR LORD, BLESS THIS MEETING AND ALLOW US TO SINCERELY AND GENUINELY ACT IN SERVING HUMANITY AND PROMOTING PEACE AND JUSTICE IN OUR CITY, OUR STATE, OUR NATION, AND THE ENTIRE WORLD. GOD BLESS US ALL, AND GOD BLESS THE UNITED STATES OF AMERICA. AMEN. 

VICTOR CAMARENA: PLEASE FACE THE FLAG. PLACE YOUR RIGHT HAND OVER YOUR HEART. IF YOU ARE A VETERAN, YOU MAY RENDER A HAND SALUTE AND JOIN ME IN THE PLEDGE OF ALLEGIANCE. [PLEDGE OF ALLEGIANCE RECITED.] 

HILDA SOLIS, CHAIR: GOOD MORNING, EVERYONE. IT'S A FINE JUNE 8TH MORNING HERE IN L.A. COUNTY, FOR SO MANY REASONS, AND WE'RE VERY PLEASED THIS MORNING TO HAVE SAED AL-QAZWINI FOR LEADING US THIS MORNING IN OUR PRAYER AND INVOCATION. HE WAS RAISED IN SOUTHERN CALIFORNIA AND CURRENTLY SERVES AS AN ASSISTANT IMAM AT THE ISLAMIC EDUCATIONAL CENTER OF ORANGE COUNTY IN COSTA MESA, CALIFORNIA. HE EARNED HIS UNDERGRADUATE DEGREE IN AT THE ISLAMIC SEMINARY IN QOM, IRAN AND IS A GRADUATE STUDENT AT THE BAYAN CLAREMONT AT THE CLAREMONT SCHOOL OF THEOLOGY. HE REGULARLY TRAVELS AROUND THE UNITED STATES TO LECTURE TO MUSLIM CONGREGATIONS AND ESPECIALLY DURING RELIGIOUS HOLIDAYS. SO, WE THANK YOU FOR BEING HERE AND MAKING YOUR INVOCATION AVAILABLE TO ALL OF US. AND MAY WE CONTINUE TO CREATE STRONG BONDS. THANK YOU. [APPLAUSE.] 

HILDA SOLIS, CHAIR: FOR THE MOMENT, WE'LL GO ON TO THE AGENDA. 

LORI GLASGOW, EXEC. OFCR., EXEC. OFCR.: GOOD MORNING, MADAME CHAIR AND MEMBERS OF THE BOARD. TODAY'S AGENDA WILL BEGIN ON PAGE 3, REPORTS. ON ITEM R-1, THIS RELATES TO AGENDA ITEM NO. 10, AND THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TO JUNE 28, 2016. 28TH, 2016, CORRECT. RIGHT. ON ITEM R-2, THIS ITEM WILL BE HELD FOR A REPORT. ON PAGE 4, SPECIAL DISTRICT AGENDAS, AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION. ON ITEM NO. 2-D, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THIS ITEM BE HELD. ON ITEM 1-D, THIS MATTER IS BEFORE YOU. 

HILDA SOLIS, CHAIR: THIS ITEM IS MOVED BY SUPERVISOR SHEILA KUEHL. SECONDED WITHOUT OBJECTION, SUCH WILL BE THE ORDER. 

LORI GLASGOW, EXEC. OFCR.: ON PAGE 6, AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY, A MEMBER OF THE PUBLIC HAS REQUESTED THAT ITEM 2-H BE HELD. ITEM 1-H IS BEFORE YOU. 

HILDA SOLIS, CHAIR: MOVED BY SUPERVISOR KNABE. SECONDED WITHOUT OBJECTION. SUCH WILL BE THE ORDER. 

LORI GLASGOW, EXEC. OFCR.: ON PAGE 7, BOARD OF SUPERVISORS, ITEMS 1 THROUGH 6. ON ITEM NO. 4, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON ITEM NO. 5, THIS INCLUDES REVISIONS, AS INDICATED ON THE SUPPLEMENTAL AGENDA. THE REMAINDER OF THE BOARD OF SUPERVISORS ITEMS ARE BEFORE YOU. 

HILDA SOLIS, CHAIR: THOSE ITEMS ARE MOVED BY SUPERVISOR SHEILA KUEHL. SECONDED WITHOUT OBJECTION. 

LORI GLASGOW, EXEC. OFCR.: ON PAGE 9, CONSENT CALENDAR, ITEMS 7 THROUGH 48, ON ITEM NO. 8, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THIS ITEM BE HELD. ON ITEM NO. 10, THIS ITEM RELATES TO AGENDA ITEM R-1, AND THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TO JUNE 28, 2016. ON ITEM NO. 12, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THIS ITEM BE HELD. ON ITEM NO. 13, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THIS ITEM BE HELD. ON ITEM NO. 14, SUPERVISOR KUEHL REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JUNE 14. ON ITEM NO. 16, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THIS ITEM BE HELD. ON ITEM NO. 17, AS INDICATED ON THE SUPPLEMENTAL AGENDA, COUNTY COUNSEL REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JUNE 14, 2016. ON ITEM NO. 22, AS INDICATED ON THE SUPPLEMENTAL AGENDA, COUNTY COUNSEL REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JUNE 14, 2016. ON ITEM NO. 26, THE DIRECTOR OF PUBLIC WORKS REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JUNE 14, 2016. 26. ON ITEM 28, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THIS ITEM BE HELD. ON ITEM NO. 35, SUPERVISOR KUEHL REQUESTS THAT THIS MATTER BE CONTINUED ONE WEEK TO JUNE 14, 2016. ON ITEMS NO. 38 AND 39, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THESE ITEMS BE HELD. ON ITEM NO. 40 AND 41, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THESE ITEMS BE HELD. ON ITEM NO. 48, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THIS ITEM BE HELD. THE REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS IS BEFORE YOU. 

HILDA SOLIS, CHAIR: THOSE ITEMS ARE MOVED BY SUPERVISOR KNABE. SECONDED WITHOUT OBJECTION. 

LORI GLASGOW, EXEC. OFCR.: ON PAGE 27, MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 49-A, SUPERVISOR KUEHL AND MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM 49-B, A MEMBER OF THE PUBLIC HAS REQUESTED THAT THIS ITEM BE HELD. ON ITEM 49-C, THIS ITEM IS BEFORE YOU. 

HILDA SOLIS, CHAIR: THIS ITEM IS MOVED BY SUPERVISOR SHEILA KUEHL. SECONDED WITHOUT OBJECTION. 

LORI GLASGOW, EXEC. OFCR.: ON ITEM 49-D, THIS ITEM IS BEFORE YOU. 

HILDA SOLIS, CHAIR: THIS ITEM IS MOVED BY SUPERVISOR KNABE. SECONDED WITHOUT OBJECTION. 

LORI GLASGOW, EXEC. OFCR.: ON ITEM 49-E, THIS ITEM IS BEFORE YOU. 

HILDA SOLIS, CHAIR: THIS ITEM IS MOVED BY SUPERVISOR KUEHL. SECONDED WITHOUT OBJECTION. 

LORI GLASGOW, EXEC. OFCR.: ITEM 49-F, SUPERVISOR KUEHL REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JUNE 14, 2016. MEMBERS OF THE PUBLIC HAVE REQUESTED THAT C.S.-1 AND C.S.-2 BE HELD. THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 4. 

HILDA SOLIS, CHAIR: SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU, MADAME CHAIR, MEMBERS OF THE BOARD. I'D LIKE TO INVITE UP ANTHONY PIROZZI AND DIRECTOR ASSISTANT OF INTEGRATION, TEST, AND LAUNCH. HE'S ALSO A LOS ANGELES HARBOR COMMISSIONER AND A GOOD FRIEND, RUDY DURAN, DIRECTOR OF ENGINEERING, BOEING COMMERCIAL AIRPLANES, MITRA ROGERS, WHO HEADS UP GOVERNMENT RELATIONS, AND THE MANY SPECIAL BOEING EMPLOYEES THAT WE HAVE OUT HERE. LET'S GIVE THEM ALL THE BIG ROUND OF APPLAUSE, AS WELL. HERE, THEY'RE -- [APPLAUSE.] THEY'RE HERE TO HELP ME HONOR AND CELEBRATE BOEING'S 100TH ANNIVERSARY. AND WE ALSO HAVE IN THE CROWD, WE HAVE TWO EMPLOYEES WHO HAVE REACHED SIGNIFICANT MILESTONES WITH BOEING. ANDY SASE, IS IT SASE? OH, ANDY, RIGHT HERE. 50 YEARS WITH BOEING RIGHT HERE. [APPLAUSE.] AND WIL BRATCHER, 48 YEARS. HOW ABOUT THAT? 98 YEARS. [APPLAUSE.] AS WE ALL KNOW ON THIS BOARD, BOEING IS A LEADING CORPORATE CITIZEN, A VERY VALUED MEMBER, NOT JUST OF LONG BEACH BUT THE ENTIRE REGION. AND IT'S BEEN AN INCREDIBLE PART OF CALIFORNIA'S RICH AEROSPACE LEGACY FOR MORE THAN 90 YEARS, CONTRIBUTING TO THE PROSPERITY OF THE REGION, EMPLOYING NEARLY 15,000 RESIDENTS, AND SPENDING ABOUT $6.8 BILLION WITH MORE THAN 2,800 CALIFORNIA SUPPLIERS. AS WE KNOW, BOEING PRODUCTS PLAY A MAJOR ROLE IN OUR DAILY LIVES BY TRANSPORTING PEOPLE AND GOODS ACROSS OUR COUNTRY AS WELL AS THE GLOBE. IT'S A CRITICAL PART OF OUR AMERICA'S DEFENSE AND SPACE INDUSTRIAL BASE, BUILDING AND SUPPORTING THE WEAPONS AND EQUIPMENT THAT OUR TROOPS USE EVERY DAY TO PROTECT THE UNITED STATES AND ITS HOMELAND AND DETER AGGRESSION. SO, ON BEHALF OF MYSELF AND MY COLLEAGUES AND THE BOARD AND THE 10 MILLION RESIDENTS HERE IN LOS ANGELES COUNTY, WE WANT TO SAY HAPPY BIRTHDAY, BOEING. HAPPY 100TH ANNIVERSARY. [APPLAUSE.] 

ANTHONY PIROZZI: WELL THIS IS AN HONOR. THANK YOU, SUPERVISOR. SO, AS THE SUPERVISOR SAID, I'M ANTHONY PIROZZI REPRESENTING THE BOEING COMPANY. YOU KNOW, 100 YEARS AGO, FOUR TYPEDWRITTEN PAGE SET OUT THE ARTICLES OF INCORPORATION OF THE PACIFIC AEROPRODUCTS COMPANY, SOON TO BECOME THE BOEING COMPANY. AND IT LAID THE GROUNDWORK FOR A CENTURY OF INNOVATION, ACCOMPLISHMENTS BY GENERATIONS OF EMPLOYEES AROUND THE WORLD. I STAND HERE TODAY REPRESENTING THOSE GENERATIONS, AND I CAN'T HELP BUT FEEL THE SENSE OF PRIDE. AND LOOKING FORWARD TO OUR NEXT 100 YEARS. THAT 100 YEARS OF RICH HERITAGE IN THE AEROSPACE LEGACY STARTED RIGHT HERE IN CALIFORNIA WHEN OUR FOUNDER FIRST DISCOVERED HIS PASSION FOR AVIATION AND WAS INSPIRED TO BUILD AIRPLANES. TODAY'S RECOGNITION OF OUR CENTENNIAL HELPS TO DEEPEN OUR APPRECIATION FOR OUR SHARED HISTORY WHILE INSPIRING A GREATER CONNECTION WITH OUR COMMUNITY AND LEGACY OF INNOVATION. WE'VE BEEN INNOVATION LEADERS FOR 100 YEARS, BECAUSE BOEING EMPLOYEES HAVE CONTINUALLY BROUGHT OUR FOUNDERS' LEGACY TO LIFE WITH AN UNSHAKEABLE DETERMINATION TO TACKLE THE WORLD'S TOUGHEST CHALLENGES FOR OUR CUSTOMERS AND FOR OUR NATION. THANK YOU FOR RECOGNIZING THE VALUE OF BOEING, ITS EMPLOYEES THAT HAVE BROUGHT TO FRUITION INNOVATION FOR THE LAST CENTURY AND FOR THE NEXT 100 YEARS. AND THANK YOU TO ALL THE SUPERVISORS, ESPECIALLY OUR SUPERVISOR DON KNABE, AND THE ENTIRE BOARD FOR YOUR SUPPORT OF THE AEROSPACE INDUSTRY AND THE AMAZING WORK OUR TALENTED EMPLOYEES DO EVERY DAY AROUND THE WORLD. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. KNABE: I JUST WANTED TO ADD ABOUT THE EMPLOYEES THAT ARE WITH US TODAY THEY JUST DIDN'T -- YOU KNOW, THEY DIDN'T GET TO VOTE WHO'D TAKE A DAY OFF WORK OR SOMETHING TO COME DOWN HERE. THESE ARE VERY SPECIAL EMPLOYEES, ALL NOMINATED INDIVIDUALLY WITHIN BOEING, EITHER MAKING SIGNIFICANT CONTRIBUTIONS OVER THE YEARS OR RIGHT NOW AND THOSE THAT HAVE BEEN LONG-TERM AND UP-AND-COMERS IN THE ENGINEERING AREA, IN THE INNOVATION AREA. SO, THEY'RE SPECIALLY SELECTED TO BE HERE. SO WE WELCOME YOU AGAIN AND THANK YOU FOR ALL THAT YOU DO ON BEHALF OF BOEING. [APPLAUSE.] 

HILDA SOLIS, CHAIR: OKAY, FOLKS IN THE AUDIENCE, WE ARE GOING TO PLAY A RECORDING, AND THEN WE'RE GOING TO BEGIN MOVING ON THE ITEMS THAT HAVE BEEN HELD BY THE PUBLIC. 

LORI GLASGOW, EXEC. OFCR.: THE FOLLOWING CODE OF CONDUCT IS OPERATIVE DURING TODAY'S BOARD'S HEARING AND ALL ARE REMINDED TO ABIDE BY THE FOLLOWING RULES. SPEAKERS MUST CEASE SPEAKING IMMEDIATELY WHEN THEIR TIME IS ENDED. PUBLIC COMMENT ON AGENDA ITEMS MUST RELATE TO THE SUBJECT MATTER OF THAT ITEM. GENERAL PUBLIC COMMENT IS LIMITED TO SUBJECTS WITHIN THE JURISDICTION OF THE BOARD. PUBLIC COMMENT DOES NOT INCLUDE THE RIGHT TO ENGAGE IN A DIALOGUE WITH BOARD MEMBERS OR STAFF. PLEASE REMAIN RESPECTFUL OF THE FORUM AND REFRAIN FROM UTTERING, WRITING OR DISPLAYING PROFANE, PERSONAL, THREATENING, DEROGATORY, DEMEANING OR OTHER ABUSIVE STATEMENTS TOWARD THE PUBLIC, ANY MEMBER THEREOF, STAFF OR OTHER PERSONS. MEMBERS OF THE AUDIENCE SHOULD BE RESPECTFUL OF THE VIEWS EXPRESSED BY SPEAKERS, STAFF AND BOARD MEMBERS AND MAY NOT CLAP, CHEER, WHISTLE OR OTHERWISE DISRUPT THE ORDERLY CONDUCT OF THE MEETING. A PERSON ENGAGING IN CONDUCT THAT DISRUPTS THE MEETING IS SUBJECT TO BEING REMOVED FROM THE BOARD MEETING. IF YOU WITNESS CONDUCT OR BEHAVIOR BY OTHER MEMBERS OF THE PUBLIC THAT DISRUPTS YOUR ABILITY TO REMAIN ENGAGED OR PARTICIPATE IN THIS MEETING, PLEASE NOTIFY THE SERGEANT AT ARMS OR OTHER COUNTY STAFF. 

HILDA SOLIS, CHAIR: OKAY. WITH THAT, WE'LL CALL UP JACQUELINE AYER. SHE HAS HELD ITEM NO. 48. AND MR. ERIC PREVEN HAS HELD ITEMS 2-H, 4, 8, 12, 13, 16, 28, 38, 39, 40, 41, 48. ARNOLD SACHS HAS HELD ITEMS 2-D, 40, 48, C.S.-1 AND C.S.-2. GOOD MORNING. 

ERIC PREVEN: ERIC PREVEN FROM THE THIRD DISTRICT, THANK YOU. THAT'S A LOT OF ITEMS, BUT I'LL DO MY BEST. FIRST OF ALL, PLEASE DO NOT PLAY THAT RECORDING. IT IS SO PERSONALLY OFFENSIVE TO MEMBERS OF THE PUBLIC. THERE'S THE GUYS FROM BOEING ARE HERE BEING HERE HONORED. IT JUST MAKES IT SEEM LIKE PEOPLE IN THE PUBLIC ARE OFF. SO, PLEASE DON'T DO IT. OKAY, THANK YOU. ITEM 12, I KNOW YOU'RE LOOKING FOR SOME CIVILIANS TO HELP OUT WITH THE OVERSIGHT COMMISSION. I WOULD ASK YOU TO THINK -- LOOK A LITTLE HARDER AT THE CRITERIA, BECAUSE I THINK YOU'RE FIGHTING YOURSELF THERE. I KNOW YOU WANT PEOPLE TO SPEAK UP, TO BRING AWARENESS, TO RAISE THEIR VOICES. BUT AT THE SAME TIME, YOU'RE EXCLUDING CERTAIN GROUPS, INCLUDING FOLKS WHO MAY HAVE FILED A LAWSUIT AGAINST THE COUNTY FOR SOME OF THESE POINTS. NOW, AS SUPERVISOR KUEHL, WHO'S MADE A CAREER OUT OF INITIATING LITIGATIONS WHERE APPROPRIATE AND SO HAS THE BOARD OF SUPERVISORS, THAT'S ALL PART OF ADVOCACY. SO TO EXCLUDE SOMEONE LIKE, YOU KNOW, I'M THINKING OFF THE TOP OF MY HEAD, CAROL SOBEL OR PETER ELIASBERG OR THOSE PEOPLE WHO DO AS PART OF THEIR WORK CHASE AROUND TO MAKE SURE WE ARE DOING THINGS RIGHT, IT JUST SEEMS LIKE IT'S A TERRIBLE IDEA. YOU WANT REAL INDEPENDENCE IF POSSIBLE. ITEM 49-F IS PUBLIC COMMUNICATIONS SERVICES, INC. THAT'S THE SHERIFF'S GROUP, HAVE HIRED THEM TO HELP OUT WITH THE PHONE CALLS. THE F.C.C. HAS MADE SOME -- FORCED SOME AMENDMENTS ON THEM SO THAT NOW IT'S A LITTLE BETTER FOR THE FOLKS. SO, I'M HAPPY ABOUT THAT. I'M NOT SO HAPPY THAT WE'RE TAKING $15 MILLION OFF THIS GROUP A YEAR, THE COUNTY IS. WE'RE CHARGING 67-PERCENT COMMISSION. I KNOW YOU HAVE TO CHOKE THAT ONE DOWN LIKE A CHICKEN BONE, BUT I DON'T KNOW WHY IT WOULD BE THAT WAY. I CAN'T UNDERSTAND WHY WE'RE NOT USING SOME OF THE TECHNOLOGY TO MAKE THIS KIND OF CONNECTIVITY BETTER. AND V.O.I.P., NOBODY LIKES V.O.I.P. MORE THAN MARK RIDLEY-THOMAS. AND AT ITEM 8 TODAY, HE'S MAKING SURE CISCO IS OUT AND SOMEBODY ELSE IS IN. I DON'T QUITE GET IT, BUT IT LOOKS INTERESTING. ITEM 48 THAT SOMEBODY ELSE SIGNED UP ON IS THE ORDINANCE POSITIONS AND SUCH. I HAD TO DO THE MATH, BECAUSE IT'S A WEB OF CONFUSION. WE ARE ADDING -- I CAN CONFIRM THIS -- 30 POSITIONS TO THE SHERIFF DEPARTMENT, SO THAT'S NICE. INCIDENTALLY, THE CIVILIAN OVERSIGHT GROUP THAT YOU'RE ENGAGING ARE NOT GOING TO BE PAID AND HAVE TO COMMIT 25 HOURS A WEEK TO THAT WORK AT ITEM NO. 12. SO, I DON'T KNOW HOW IN THE WORLD YOU ARE GOING TO GET ANYBODY EXCEPT FOR A RETIREE OR I DON'T KNOW WHO. VERY, VERY HARD TO SEE THAT ONE, FRANKLY. ITEM 39 IS T.S.A. WOULD LIKE TO CANINE SUPPORT, AND I THINK THIS IS A GREAT WAY TO GIVE THEM A LITTLE MONEY TO WORK ON THAT PROJECT. AND I THINK THAT THE MIKE ANTONOVICH SCHOOL OF CANINE TRAINING OUGHT TO BE BROUGHT FORWARD SO WE CAN FINALLY PUT DOGS TO USE IN THE JAILS AND ALL OVER THE COUNTY AND NOT JUST FOR INCARCERATION BUSINESS, FOR ALL SORTS OF BUSINESS, BECAUSE THESE DOGS ARE FANTASTIC. NOBODY'S BEEN A BIGGER CHAMPION. AND QUITE FRANKLY, THOSE SCANNERS THAT WE HAVE SPEND, I BELIEVE, TENS OF MILLIONS OF DOLLARS ON NOW ARE INSANE AND NEED TO BE DISPATCHED, BECAUSE THEY DON'T REALLY WORK AND GET ANYTHING WE NEED. SO THAT'S ONE THING THAT I WOULD SUGGEST ON THAT. I GASPED WHEN I SAW ITEM 40 TODAY, WHICH IS THE M.T.A. CONTRACT FOR $600 MILLION, SHERIFF'S DEPARTMENT HELPS PROVIDE SOME OF THAT. SO, HOW IS THAT NOT SELF-DEALING IN A WAY IF THE BOARD OF SUPERVISORS AND THEY'RE ALSO ON M.T.A.? IT'S JUST A -- THERE'S A WEIRDNESS ON THAT, BUT I'M SURE THAT'S BEEN LOOK AT BY SMARTER PEOPLE THAN ME. ITEM 13 IS, THANK YOU SUPERVISOR SOLIS, AFTER ITEM 2 LAST WEEK FOR BRINGING BACK 7-ELEVEN FOR ONE MORE ALCOHOL LICENSE. I THINK IT'S PROBABLY APPROPRIATE. PUBLIC WORKS HERE AT ITEM 28 IS ADDING A SENIOR ENVIRONMENTAL SCIENTIST WHO MAKES BETWEEN $220,000 AND $287,000 A YEAR. SO, I'M GOING TO GO INTO THAT LINE OF WORK SOON, BECAUSE I THINK THAT SOUNDS LIKE A GREAT DEAL. ITEM 4, IF YOU'LL INDULGE ME IS -- 

HILDA SOLIS, CHAIR: NEXT SPEAKER. 

ARNOLD SACHS: YES, THANK YOU. GOOD MORNING. ARNOLD SACHS. AND QUITE THE -- I THINK YOU OUGHT TO HAVE A MUSICAL INTERLUDE BEFORE YOU DO THAT ANNOUNCEMENT, ACTUALLY. AND BY THE WAY, WHAT HAPPENED TO THE SLIPS OF PAPER THAT YOU USED TO HAND OUT REGARDING THE PUBLIC'S RIGHT TO SPEAK OR NOT SPEAK OR WHATEVER? THAT WAS AN INTEGRAL PART OF YOUR PRESENTATION, ACCORDING TO THE COUNTY COUNSEL. BUT THAT'S COUNTY COUNSEL. 

HILDA SOLIS, CHAIR: IT'S PRINTED IN THE AGENDA NOW, IF YOU READ. 

ARNOLD SACHS: I'M TALKING ABOUT -- JUST NOBODY'S SAYING ANYTHING ABOUT ANYTHING. COMMUNITY DEVELOPMENT COMMISSION. YOU KNOW I WAS GOING THROUGH SOME THINGS, AND ACCORDING TO THIS DOCUMENT, THIS IS FROM MAY 13, 2014, IT STATES THAT -- TALKING ABOUT THE HOUSING DEVELOPMENT CORPORATION. AND IT'S THE HOUSING DEVELOPMENT CORPORATION IS A CALIFORNIA NONPROFIT CORPORATION FORMED IN OCTOBER 16TH, 1989 BY THE LOS ANGELES COUNTY BOARD OF SUPERVISORS. H.D.C.'S PURPOSE IS TO PROVIDE SERVICES TO ASSIST LOCAL GOVERNMENTS IN MEETING THEIR LEGAL OBLIGATIONS FOR AFFORDABLE HOUSING. BUT IN THIS ITEM, H.D.C., WHICH IS THE HOUSING CORPORATION, IS NEGOTIATING WITH THE CALIFORNIA COMMUNITY DEVELOPMENT COMMISSION, WHICH YOU ARE THE CALIFORNIA COMMUNITY DEVELOPMENT COMMISSION. SO ESSENTIALLY YOU'RE NEGOTIATING WITH YOURSELF. AND THEN WE CAN THROW IN, AMONGST OTHER THINGS, THE HOUSING AUTHORITY OF THE COUNTY OF LOS ANGELES, THE COMMUNITY DEVELOPMENT CORPORATION, THE COMMUNITY REDEVELOPMENT AGENCY, WHICH YOU ALSO CHAIR, AND THE HOUSING DEVELOPMENT CORPORATION. SO, YOU'RE CHAIRS OF ALL THESE DIFFERENT AGENCIES AND YOU HAVE NO CLUE AS TO WHAT THE HELL IS GOING ON WITH HOUSING. IT'S PRETTY AMAZING THAT YOU CAN GET AWAY WITH THAT. I HELD ITEM 40. IT'S, AGAIN, THE METRO CONTRACT WITH THE SHERIFFS. YOU SIT ON THE BOARD. IT WOULD BE NICE IF YOU LOOKED AT THIS METRO AUDIT THAT THEY DID FOR PROP A AND PROP C WHERE THERE'S A DIFFERENCE IN REVENUE -- DIFFERENCE IN REVENUE, NOT EXPENSES -- OF $100 MILLION. AND THAT'S PROP A AND PROP C. THAT DOESN'T INCLUDE MEASURE R, WHICH IS A DIFFERENCE IN REVENUE, ACCORDING TO YOUR PROJECTIONS, OF $600 MILLION. SO, WHAT'S A LITTLE MONEY WITH METRO AND THE COUNTY? WE GOT PLANS. WE JUST DON'T HAVE ANY MONEY. LEAD ON. THAT'S A RIFF ON FIGHT ON. SO THE... TEAM EX-LAX IS MOVING SLOWLY BUT SURELY. I HELD ITEM C.S.-1, THE COUNTY SEAL, AND I HELD -- THERE WAS A LITTLE CARTOON ABOUT THE COUNTY SEAL, AND IT REFERRED TO THE INDIGENOUS INDIANS WHO LIVED IN CALIFORNIA WHEN THE SPANISH, THEY MADE UP THE MISSIONS AND HOW THEY WERE ABUSED BY THE MISSIONARIES. SO I WAS WONDERING IF YOU ARE GOING TO INCLUDE THAT AS ADEQUATE REPRESENTATION OF THE MISSIONS WHERE YOU WANT TO PUT THE CROSS ON THIS SEAL AND INCLUDE THE FACT THAT THEY WERE ABUSING THE INDIGENOUS PEOPLE OF CALIFORNIA. 

HILDA SOLIS, CHAIR: I'LL CALL UP AGAIN JACQUELINE AYER IF SHE'S HERE. SHE'S REQUESTED TO SPEAK ON ITEM 48. OKAY. DO YOU WANT TO COME UP? OKAY. ALL RIGHT. OKAY. THAT'S FINE. IT'S HELD. WE'LL BRING YOU UP LATER. THANK YOU. SUPERVISOR ANTONOVICH HAS SEVERAL PRESENTATIONS THIS MORNING. SUPERVISOR? 

SUP. ANTONOVICH: WELL, FIRST LET ME RECOGNIZE AN INDIVIDUAL WHO CAME ALL THE WAY FROM ANTELOPE VALLEY, VICTOR CAMARENA, WHO GAVE US OUR PLEDGE OF ALLEGIANCE. HE SERVED IN THE UNITED STATES NAVY. HE IS MARRIED. HE HAS A SON AGE 2. AND HE'S A CIVILIAN POSITION RIGHT NOW AS A VETERAN INTERN WITH THE OFFICE OF CLERICAL SUPPORT WITH THE DEPARTMENT OF PUBLIC SOCIAL SERVICES. SO, WE ARE REALLY PLEASED THAT HE SERVED HIS COUNTRY AND NOW HE'S SERVING THE COUNTY IN OUR D.P.S.S. SO, THANK YOU, VICTOR, FOR COMING DOWN. [APPLAUSE.] NOW WE'RE GOING RECOGNIZE CHATSWORTH PARK ELEMENTARY SCHOOL. AND TODAY WE WELCOME CRISTIAN CABALLERO, CATEGORICAL PROGRAM ADVISOR OF CHATSWORTH PARK ELEMENTARY, AS WE RECOGNIZE HIM ON BECOMING A CALIFORNIA GOLD RIBBON SCHOOL, ONE OF ONLY 44 SCHOOLS IN LOS ANGELES UNIFIED SCHOOL DISTRICT TO RECEIVE THIS DESIGNATION. IT'S A SMALL, HISTORIC, NEIGHBORHOOD SCHOOL THAT OPENED IN 1879. SO, NONE OF US WERE HERE AT THAT TIME. AND IT'S ONE OF THE OLDEST SCHOOLS IN THE SAN FERNANDO VALLEY. ACHIEVED GREAT SUCCESS AND RECOGNITION FOR IMPARTING QUALITY EDUCATION TO THEIR YOUNG STUDENTS, PREPARING THEM FOR A CAREER OF ACADEMIC ACHIEVEMENT AND GIVING THEM A SOLID FOUNDATION FOR LIFE. SO, WE WANT TO THANK YOU, CRISTIAN, AND CONGRATULATIONS TO THE CHATSWORTH PARK ELEMENTARY SCHOOL FOR THIS ACHIEVEMENT AND YOUR HARD WORK AND GOD BLESS. [APPLAUSE.] 

CRISTIAN CABALLERO: GOOD MORNING. MY NAME IS CRISTIAN CABALLERO. IT'S AN HONOR TO BE HERE TODAY ACCEPTING THIS HONOR. YES, INDEED, WE WERE ONE OF THE 44 SCHOOLS IN LOS ANGELES DISTRICT. WE'RE VERY PROUD OF OUR STUDENTS, OUR PARENTS, OUR COMMUNITY. IT WAS AN EFFORT BY ALL STAKEHOLDERS, AND WE'RE VERY PROUD OF OUR SCHOOL, CHATSWORTH PARK ELEMENTARY. [APPLAUSE.] 

SUP. ANTONOVICH: THIS IS LITTLE SUMMER, SIX MONTHS OLD, LITTLE TERRIER LOOKING FOR A HOME. YOU CAN CALL 562-728-4610. LITTLE SUMMER LOOKING FOR A HOME. BEGIN THIS SUMMER OF JUNE GIVING A LOT OF LOVE AND TENDERNESS AND WET KISSES. SUMMER HAD TO POWDER HER NOSE, SO SHE WAS A LITTLE LATE, BUT SHE'S OKAY. 

LORI GLASGOW, EXEC. OFCR.: MADAME CHAIR, THE FOLLOWING ITEMS ARE BEFORE YOU: ITEM NO. 2-D, 2-H, 4, 8, 13, 16, 28, 38, 39, 40, 41, 48 AND 49-B. 

HILDA SOLIS, CHAIR: THOSE ITEMS ARE MOVED BY SUPERVISOR ANTONOVICH, SECONDED WITHOUT OBJECTION. AND WE HAVE ONE SPEAKER WANTING TO SPEAK ON ITEM NO. 12, MARK ANTHONY JOHNSON. YOU'RE OKAY. I UNDERSTAND THERE ARE SEVERAL SPEAKERS ON ITEM 12, SO WE'LL ACCORDINGLY TAKE THOSE NAMES. SO, ON ITEM NO. 12, LET'S START WITH MARK ANTHONY JOHNSON. START THE CLOCK. IS THE MIC ON? 

MARK ANTHONY JOHNSON: GOOD MORNING, SUPERVISORS. MARK ANTHONY JOHNSON WITH DIGNITY AND POWER NOW AND THE COALITION TO END SHERIFF VIOLENCE. SO, WE'RE HERE TODAY, BECAUSE WE KNOW THAT THE SUPERVISORS WILL BE APPROVING A CRITERIA REGARDING HOW YOU WILL VET COMMISSIONERS FOR THE CIVILIAN OVERSIGHT COMMISSION OF THE SHERIFF'S DEPARTMENT. THE COALITION IS VERY CONCERNED ABOUT MAKING SURE THAT THIS COMMISSION IS CREDIBLE, THAT IT'S EFFECTIVE, THAT IT'S IMPACTFUL. AND SO TODAY WE HAVE LAUNCHED A SLATE OF NOMINEES WHO WE WOULD LIKE TO PRESENT TO YOU WHO WE BELIEVE ARE THE MOST EFFECTIVE AND WOULD BE THE MOST IMPACTFUL AND THE MOST CREDIBLE PEOPLE TO SIT ON THIS COMMISSION. WE KNOW AS THE COMMISSION WAS FORMED, THE ALLOWANCE OF FORMER LAW ENFORCEMENT TO SIT ON THE COMMISSION HAS PROVIDED AND CREATED A LOT OF CONCERNS IN THE COMMUNITY. THIS SLATE IS OUR MOTION TO ADDRESS THOSE CONCERNS. THE FOLKS WHO YOU WILL HEAR FROM TODAY ARE A SECTION OF THIS SLATE OF 10 PEOPLE WHO WE WANT TO FILL THE REMAINING FOUR SEATS ON THIS CIVILIAN OVERSIGHT COMMISSION. THEY INCLUDE FOLKS OF THE CALIBER OF PATRISSE CULLORS, FOUNDER OF DIGNITY AND POWER NOW AND COFOUNDER OF BLACK LIVES MATTER. IT INCLUDES PRISCILLA OCEN, ASSISTANT PROFESSOR OF LAW AT LOYOLA LAW SCHOOL, WHO'S DONE TREMENDOUS WORK AROUND EXPOSING THE CONDITIONS THAT WOMEN AND L.G.B.T.Q. FOLKS ARE EXPERIENCING IN INCARCERATION. IT INCLUDES SAMUEL PAZ. IT INCLUDES A HOST OF FOLKS WHO HAVE DEDICATED THEIR LIVES AND THEIR WORK TO HAVING STRONG RELATIONSHIPS WITH THE COMMUNITY BUT ALSO PROTECTING THE CIVIL AND HUMAN RIGHTS OF INCARCERATED PEOPLE AND THEIR LOVED ONES AND COMMUNITIES. AND YOU'LL HEAR FROM A FEW OF THESE FOLKS TODAY. WE'LL BE MEETING WITH YOU AND REACHING OUT TO YOUR OFFICES TO HELP INTRODUCE YOU TO THE FOLKS ON THE COALITION SLATE FOLLOWING THIS MEETING. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU. WE HAVE OTHER SPEAKERS THAT HAVE REQUESTED TO SPEAK ON THIS ITEM: RABBI HEATHER MILLER, MICHELLE YNFANTE, KIM MIGUEL, LLOYD WILKEY. AND PLEASE JUST INTRODUCE YOURSELF AS YOU BEGIN. 

RABBI HEATHER MILLER: GOOD MORNING. MY NAME IS RABBI HEATHER MILLER, AND I AM ON THE SLATE OF 10 PEOPLE CHOSEN BY THE COMMUNITY. THOUSANDS OF PEOPLE HAVE CHOSEN MYSELF AND OTHERS TO SERVE ON THE CIVILIAN OVERSIGHT COMMISSION TO THE L.A. COUNTY SHERIFF'S DEPARTMENT. THIS GROUP IS BROAD. WE'RE DIVERSE. WE COME FROM DIFFERENT EXPERIENCES. I COME FROM THE SPIRITUAL REALM. OTHERS COME FROM FORMERLY INCARCERATED EXPERIENCES. OTHERS COME FROM EXPERIENCES TRAINING SHERIFFS THEMSELVES. WE ARE ALL COMMITTED IN OUR HEARTS AND MINDS TO BRINGING ABOUT JUSTICE, TO BRINGING ABOUT OVERSIGHT. IN MY TRADITION, THE JEWISH TRADITION, WE LEARN FROM DEUTERONOMY 4:9 THAT EVERYONE SHOULD [SPEAKING HEBREW], WE SHOULD EACH GUARD OURSELVES. AND THAT INCLUDES GUARDING THE SHERIFF'S DEPARTMENT, TO UNDERSTANDING AND SCRUPULOUSLY LOOKING AT WHAT THE SHERIFF'S DEPARTMENT IS DOING, BECAUSE THEY ARE PEOPLE IN POWER, THEY HAVE AUTHORITY. THEY HAVE THE POWER AND AUTHORITY TO USE LETHAL FORCE. AND THE COMMUNITY IS ASKING FOR REPRESENTATION TO HELP SHAPE THE POLICIES, TO HELP UNDERSTAND AND MAKE ACCOUNTABLE WHAT THE SHERIFF'S DEPARTMENT DOES. TO THE PEOPLE THAT IT SERVES. LOS ANGELES COUNTY IS THE LARGEST AND MOST DIVERSE. WE HAVE THE LARGEST AND MOST DIVERSE SHERIFF'S DEPARTMENT, SERVES THE LARGEST AND MOST DIVERSE COMMUNITY. AND WE NEED TO MAKE SURE THAT PEOPLES OF VARIOUS RACIAL, SEXUAL ORIENTATION GENDER, SOCIOECONOMIC, RELIGIOUS, AND OTHER BACKGROUNDS ARE REPRESENTED ON THIS COMMISSION. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU VERY MUCH. NEXT SPEAKER? 

MICHELLE YNFANTE: HELLO MY NAME IS MICHELLE YNFANTE. I AM HERE WITH DIGNITY AND POWER NOW IN SUPPORT OF THE 20 APPLICANTS THAT ARE BEING PUT FORWARD TO THE L.A. COUNTY BOARD OF SUPERVISORS. AND GOOD MORNING TO ALL OF YOU, SUPERVISORS. THANK YOU FOR THE OPPORTUNITY TO SPEAK. I'M ONE OF THE APPLICANTS, AND I'M VERY MUCH LOOKING FORWARD TO WORKING AND MAKING A HUGE CHANGE IN THE SYSTEM. AND I APPRECIATE THAT YOU VOTED IN THE COMMISSION, BECAUSE IT'S AN OPPORTUNITY FOR THE COMMUNITY TO COME TOGETHER AND WORK WITH THE SHERIFF'S DEPARTMENT AND BRING TRANSPARENCY AND ACCOUNTABILITY. I WOULD JUST LIKE TO SAY AGAIN, WE WOULD REALLY SUPPORT, AND LIKE VERY IMPORTANT, WOULD SUPPORT THE 20 PEOPLE THAT ARE BEING BROUGHT FORWARD TO YOU AND OUR ORGANIZATION BEING A PART OF THAT. SO, THANK YOU VERY MUCH FOR THE OPPORTUNITY TO SPEAK. 

HILDA SOLIS, CHAIR: THANK YOU VERY MUCH, MA'AM. NEXT SPEAKER? 

KIM MCGILL: MY NAME IS KIM MCGILL FROM THE COMMUNITY JUSTICE COALITION. WE'RE ALSO HONORED TO BE HERE IN SUPPORT OF THIS SLATE OF CANDIDATES AND ARE VERY PROUD OF THE FACT THAT MANY OF OUR MEMBERS HAVE VOTED AND VETTED FOR THESE CANDIDATES. WE GO EVERY WEEK TO THE L.A. POLICE COMMISSION. AND I CAN TELL YOU THAT EVEN WHEN YOU HAVE CIVILIAN, SO-CALLED CIVILIAN OVERSIGHT, IT DOESN'T MEAN THAT THERE'S A COMMUNITY VOICE OR COMMUNITY REPRESENTATION ON THE COMMISSION. WE ARE NEVER SPOKEN TO. WE HAVE LITTLE OPPORTUNITY TO MEET WITH THEM INDIVIDUALLY OR AS A GROUP. NONE OF THE POLICIES THAT THE COMMUNITY PUTS FORWARD ARE TAKEN SERIOUSLY, AND THERE'S NO ONE ON ANY POLICE COMMISSION I'VE EVER SEEN WHO HAS FORMER SYSTEM EXPERIENCE. I WONDER WHO SPEAKS FOR US ON THESE COMMISSIONS, THOSE OF US WHO HAVE BEEN DETAINED AT THE COUNTY JAILS, WHO HAVE BEEN DEMORALIZED IN COUNTY JAILS AND IN INTERACTIONS WITH SHERIFFS. I WONDER WHO SPEAKS FOR THE FAMILIES WHOSE LOVED ONES HAVE BEEN KILLED BY SHERIFFS IN THE COMMUNITY? WHO SPEAKS FOR THE PARENTS WHO HAVE FOUND OUT FROM THE MEDIA OR FROM A FAMILY MEMBER THAT THEIR LOVED ONE WAS KILLED BY THE SHERIFFS, AND NOT BY THE SHERIFF'S DEPARTMENT THEMSELVES? WHO SPEAKS FOR THE FAMILY MEMBER WHO CAN'T SEE THEIR LOVED ONE AT THE CORONER'S OFFICE AND CAN HAVE NO CONTACT AT THE HOSPITAL WITH THEIR LOVED ONE TO SEE THE PERSON WAS KILLED. WHO SPEAKS FOR THE PEOPLE THAT HAVE ENDURED CONFINEMENT IN THE COUNTY JAILS, SOMETIMES FOR WEEKS AND MONTHS WITHOUT VISITS, WITHOUT PHONE CALLS, WITHOUT MEDICAL ATTENTION? WHO SPEAKS FOR THE PEOPLE THAT DON'T HAVE THEIR MEDICATION INSIDE THE COUNTY JAILS, THAT THOSE OF US WHO HAVE BEEN LOCKED UP THERE HEAR THEM SCREAM AND CRY ALL NIGHT LONG, NIGHT AFTER NIGHT AFTER NIGHT. WHO SPEAKS FOR THE PEOPLE THAT ARE KEPT IN COUNTY JAILS, THE MAJORITY OF THE PEOPLE IN COUNTY JAIL SYSTEM, WHO SHOULD BE RELEASED UPON ARREST AND NOT GO THROUGH THE COUNTY JAIL SYSTEM AT ALL, BECAUSE THEY'RE THERE FOR SO-CALLED OFFENSES THAT ARE SO MINOR THAT THEY IMMEDIATELY AT ARRAIGNMENT ARE SET FREE. WHO SPEAKS FOR ALL OF US THAT HAVE GONE THROUGH THE SYSTEM AND HAVE BEEN GIVEN NO BAIL REDUCTIONS, NO OPPORTUNITY TO POST A LEGITIMATE BAIL, AND HAVE TO ENDURE THE HARSHEST BAIL SYSTEM IN THE NATION? WE WILL HAVE NO REPRESENTATION ON THIS COMMISSION IF PEOPLE THAT HAVE BEEN MOST IMPACTED BY SHERIFF'S VIOLENCE AND MOST IMPACTED BY INCARCERATION DON'T HAVE A VOICE ON THAT COMMISSION. 

HILDA SOLIS, CHAIR: THANK YOU. NEXT SPEAKER? 

LLOYD WILKEY: THANK YOU, AND GOOD MORNING. MY NAME IS LLOYD WILKEY. I'M A HUMAN RELATIONS CONSULTANT, AND I'M FOR -- A BIG SHARE OF MY WORK IS WORKING WITH THE MUSEUM OF TOLERANCE TO TRAIN LAW ENFORCEMENT. I HAVE DONE THAT FOR 20 YEARS. SO, I'VE HAD A LOT OF INTERACTION WITH THE SHERIFF'S DEPARTMENT, AND I'VE ALSO BEEN A COMMUNITY PERSON. AND I'M REALLY HAPPY TO SAY THAT I'M GLAD THAT THIS COALITION OF FOLKS HAS ADDED MY NAME TO THIS LIST OF FOLKS THAT THEY WANT TO HAVE TO BE A PART OF THIS COMMISSION. MY WORK ALSO INVOLVES WORKING WITH THE YOUTH. I HAVE A YOUTH PROGRAM THAT I HAVE DIRECTED FOR 20 YEARS. AND I, TOO, WANT TO TRY TO BRING A PERSPECTIVE FROM THE COMMUNITY, FROM THOSE WHO ARE MOST IMPACTED BY POLICING. REALLY, JUST THAT'S THE BOTTOM LINE, FOR THOSE WHO HAVE EITHER INTERACTIONS WITH LAW ENFORCEMENT OR THE CITIZENS OF LOS ANGELES COUNTY WHO WOULD BE INTERESTED IN MORE ACCOUNTABILITY AND TRANSPARENCY AND HAVING THEIR PUBLIC SERVANTS ACTUALLY BE WORKING IN THEIR BEST INTEREST. AND SO, I WANT TO BE THERE AND BE A PART OF THAT AND BRING MY 25 YEARS OF EXPERIENCE AT ALL OF THAT, THE THINGS THAT I'VE LEARNED, BEEN LOOKING FOR AN OPPORTUNITY LIKE THIS ONE FOR ABOUT 25 YEARS. AND I'M HAPPY TO HAVE IT NOW. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU. I'LL CALL UP RABBI JONATHAN KLEIN, STEVE ROGERS, PASTOR CUE, JAN MARIE. 

RABBI JONATHAN KLEIN: GOOD MORNING MORNING, SUPERVISORS. RABBI JONATHAN KLEIN WITH CLERGY AND LAITY UNITED FOR ECONOMIC JUSTICE. AND I'M VERY GLAD TO SEE WE ARE MAKING OUR WAY ALONG IN PURSUING JUSTICE. IT SAYS IN THE BOOK OF PSALMS, CHAPTER 34, IT SAYS [SPEAKING HEBREW], WHICH MEANS, "GUARD YOURSELF FROM EVIL. TURN FROM EVIL AND DO GOOD. SEEK PEACE AND PURSUE IT." THE PURSUIT OF PEACE AND THE PURSUIT OF JUSTICE IS TIED TO THIS BODY CREATING STRUCTURES THAT ACTUALLY MOVE US ALONG, NOT JUST ANOTHER STRUCTURE THAT CREATES A WATCHDOG FOR LAW ENFORCEMENT OR A WATCHDOG OF THE COMMUNITY, WHICH IS WHAT WE HAVE A NERVOUSNESS ABOUT, THAT WITH THE PRESENCE OF LAW ENFORCEMENT OVERWHELMING THIS BODY, THAT IT WILL NO LONGER SERVE AS A CIVILIAN OVERSIGHT COMMISSION. WE WANT TO MAKE SURE THAT THESE CRITERIA ARE TAKEN SERIOUSLY, BECAUSE THE FOLKS THAT ARE ON THIS SLATE AND THE IDEOLOGY THAT'S GONE INTO CREATING THESE CRITERIA IS MEANT NOT TO JUST CREATE A BODY THAT DOESN'T DO ANYTHING BUT WILL REALLY PURSUE PEACE, SEEK PEACE FOR THE CITY, JUSTICE FOR THE CITY, AND CREATE A MORE EQUITABLE SYSTEM. CLERGY AND LAITY UNITED FOR ECONOMIC JUSTICE FULLY SUPPORTS MOVING FORWARD WITH THIS SLATE. WE'RE VERY PROUD TO HAVE RABBI HEATHER MILLER ON THIS SLATE. AND WE HOPE THAT YOU WILL TAKE ALL OF THE -- ALL OF THESE INDIVIDUALS INTO CONSIDERATION. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU. NEXT SPEAKER? 

STEVE ROGERS: MY NAME IS STEVE ROGERS. I'M THE CIVILIAN OVERSIGHT CAMPAIGN LEAD WITH DIGNITY AND POWER NOW. I'M ALSO A MENTOR COORDINATOR WITH FRIENDS OUTSIDE. YOU KNOW, WE WANT TO TALK TO YOU GUYS ABOUT THE CRITERIA THAT'S GOING FORWARD. I JUST WANT TO THANK YOU GUYS FOR THE TIME TODAY. THANK YOU FOR PUTTING THE EFFORT ON THIS. I KNOW THIS HAS BEEN A LONG PROCESS. SUPERVISOR ANTONOVICH, I NOTICE THAT YOU ARE RUNNING FOR STATE SENATE IN MY CITY. YOU KNOW, I WISH YOU THE BEST. YOUR NAME IS WELL RESPECTED IN MY TOWN. SO, THERE'S A LOT OF PEOPLE IN OUR COMMUNITY THAT BELIEVE THAT LAW-ENFORCEMENT MISCONDUCT IS ON THE RISE. THERE'S A LOT OF PEOPLE THAT BELIEVE THAT LAW ENFORCEMENT IS DOING A GREAT JOB. THEY'RE PUTTING THEIR LIVES ON THE LINE. THERE'S A LOT OF PEOPLE IN UNIFORM THAT I LOOK UP TO. SOME OF MY MENTORS WEAR THE BADGE. THIS COMMISSION IS THE BEST OPPORTUNITY WE HAVE TO SEE WHAT'S GOING ON AND TO PUT CLAIMS TO REST ONE WAY OR THE OTHER. WE NEED TO HAVE PEOPLE IN THE COMMUNITY TO BE ABLE TO SEE IN TO SEE WHAT'S GOING ON. SO WE PUT TOGETHER A SLATE OF 10 NAMES. THIS WAS NOT EASILY ARRIVED ON. WE'VE GOT MAYBE 30, 40 DIFFERENT ORGANIZATIONS THAT HAVE WORKED ON THIS LIST REPRESENTING THOUSANDS OF PEOPLE THAT ARE INVOLVED IN THIS WORK THAT DEAL WITH PEOPLE THAT ARE DIRECTLY IMPACTED. AND WE SPENT A LOT OF TIME TRYING TO COME UP WITH THE BEST PEOPLE, PEOPLE WHO ARE COMMITTED, PEOPLE WHO UNDERSTAND THE WORK, PEOPLE WHO UNDERSTAND THE RESPONSIBILITY OF BEING ON THIS COMMISSION. AND WE JUST WANT TO STRONGLY RECOMMEND AND URGE YOU GUYS TO CHOOSE FROM THAT LIST. WE UNDERSTAND YOU GUYS ARE GOING TO BE PICKING 20 PEOPLE THAT WILL GO FORTH AT THIS POINT. SO WE WOULD JUST LIKE TO SEE AS MANY PEOPLE AS POSSIBLE FROM THAT LIST. YOU KNOW, IF I'M NOT YOUR FLAVOR, THERE'S NINE OTHER PEOPLE ON THERE THAT DO THIS WORK AND THAT UNDERSTAND WHAT'S GOING TO BE AHEAD OF THEM. AND WE THINK THAT WOULD BE A GOOD VEIN TO THE COMMUNITY, TO SHOW THAT YOU GUYS ARE LISTENING, THAT YOU ARE INVOLVED, THAT YOU ARE ENGAGING THE PUBLIC, AND THAT YOU ALLOW US TO BE PART OF THIS WORK GOING FORWARD. 

HILDA SOLIS, CHAIR: THANK YOU VERY MUCH. NEXT SPEAKER? SIR? 

PASTOR CUE: GOOD MORNING. I'M PASTOR CUE FROM THE CHURCH WITHOUT WALLS, SKID ROW, ALSO THE BLACK JEWISH JUSTICE ALLIANCE AND CREATING JUSTICE L.A. I'M HERE IN SUPPORT OF THE 20 CANDIDATES THAT WE HAVE SET FORTH, THAT WE HAVE PRESENTED. I'M HERE IN A LITTLE DIFFERENT SENSE, BECAUSE I'M HERE WITH SOME ANXIETIES ABOUT THE PROCESS AND THE FACT THAT WE DID NOT RECEIVE SUBPOENA POWER AND FORMER LAW ENFORCEMENT'S PLEA TO BE ON THE BOARD HAS BEEN HEARD BUT IT SEEMED LIKE OUR PLEAS HAVE NOT BEEN HEARD. AND WORKING WITH GOING TO THE POLICE COMMISSIONS EVERY TUESDAY AND WITNESSING HOW THE COMMISSION WORKS AND HOW WE DON'T REALLY HAVE REPRESENTATION, THE POLICE COMMISSION BEING SHUT DOWN EVERY WEEK BY BLACK LIVES MATTER AND OTHER GROUPS. I'M REALLY CONCERNED ABOUT WHERE OUR CITY IS GOING, THAT THOSE WHO ARE MOST ABUSED, THOSE WHO ARE MOST IN CONTACT WITH LAW ENFORCEMENT. AND IN SKID ROW, FOR INSTANCE, WE ENCOUNTER POLICE, LAW ENFORCEMENT, MORE THAN ANY OTHER COMMUNITY. 50 POLICE OFFICERS FOR 50 SQUARE BLOCKS BECAUSE IT'S CONSIDERED TO US A CONTAINMENT ZONE. WELL, WE THINK ABOUT THAT. THE INTERACTION THAT WE HAVE IS NOT GOING TO BE THE SAME REACTION THAT OTHER PEOPLE IN THE CITY HAS. WE FEEL LIKE WE'RE SOMETIMES THE PEOPLE ON SKID ROW, HOMELESS PEOPLE FEEL LIKE THEY'RE TARGET OF LAW ENFORCEMENT. AND THEN WHEN THEY GET INTO SHERIFF CUSTODY, WE JUST HAD A YOUNG WOMAN THAT WAS KILLED, OR SHE ENDED UP DEAD. AND WE'RE HEARING THAT SHE WAS -- SHE HUNG HERSELF WITH A TELEPHONE CORD, WAKIESHA WILSON, IN CUSTODY OF LAW ENFORCEMENT. AND SO, I COME FROM THAT PERSPECTIVE. HER MOTHER HASN'T HEARD ANYTHING, AND WE DON'T WANT THIS TO CONTINUE. 

HILDA SOLIS, CHAIR: THANK YOU. WE'LL CALL UP NEXT TANISHA DENARD, ARNOLD SACHS, ERIC PREVEN. 

ERIC PREVEN: YES, IT'S ERIC PREVEN, AND THIS HAS BEEN A LONG TIME COMING. I PARTICIPATED IN THE CITIZENS COMMISSION ON JAIL VIOLENCE HEARINGS BACK IN, I THINK IT WAS 2011 OR 2012. AND I'VE EXPERIENCED THE SHERIFF BACA AND ALSO SHERIFF MCDONNELL AND THE INTERIM GUY. AND, YOU KNOW, THE SHERIFF'S DEPARTMENT IS A POWERFUL GROUP, AS WE'VE SEEN. KATHRYN BARGER WAS ELECTED LAST NIGHT, I THINK, WITH SOME OF THAT EFFORT. AND, YOU KNOW, THE OVERWHELMING MAJORITY OF THIS IS A GOOD GROUP, BUT THEY'VE HAD SOME SYSTEMIC PROBLEMS. AND I HAVE BEEN, BECAUSE OF MY WATCHDOG BEHAVIOR HERE AT THE BOARD OF SUPERVISORS, I'VE HAD A CLEAR VIEW OF THAT. AND I HAVE NEVER SHIED AWAY FROM SPEAKING OUT ABOUT IT. AND FOR THAT REASON, I ASSUME I'M NOT QUALIFIED FOR THIS PARTICULAR COMMISSION. BUT I'M HOPING THAT THAT'S NOT TRUE. I'M HOPING THAT THIS GROUP, THIS NEW BOARD OF SUPERVISORS IS SERIOUS ABOUT PROVIDING REAL CIVILIAN OVERSIGHT, BECAUSE I'M CONCERNED ABOUT A 25-HOUR COMMITMENT, IF THAT'S REAL, FOR NO MONEY. TODAY, AS I MENTIONED, THAT ITEM, 40-A, WE ADDED 30 FULL-TIME SHERIFF POSITIONS, SUPERVISOR KUEHL, AND THAT'S FINE. BUT TO GO INTO THIS PROCESS OF TRYING TO BRING PEOPLE TO BE REAL CRITICS, SERVE FOR A SHORT PERIOD, PROVIDE GUIDANCE, PROVIDE, YOU KNOW.. BASICALLY WHAT YOU NEED IS CIVILIANS, LIKE ALL OF THESE GROUPS WHO ARE GOING TO BE PAYING CLOSE ATTENTION AND ARE GOING TO BE GIVING EVERYBODY THE FEELING THAT PUBLIC SCRUTINY IS PRESENT. AND I THINK THAT THAT BALANCE ABOUT TRANSPARENCY AND ACCOUNTABILITY IS CRITICAL. AND I WOULD ASK YOU ONE MORE TIME TO RECONSIDER ELIMINATING PEOPLE WHO HAVE CLASHED WITH THE CURRENT SYSTEM, BECAUSE IT'S FAIR TO NOTE THAT THE TWO LEADERS WITH WHOM I CLASHED WITH FOR THE LAST FOUR YEARS ABOUT THIS EGREGIOUS BEHAVIOR HAVE BEEN ARRESTED. SO, AND THERE'S REASONS TO SEE WHY SOMEONE WOULD MAKE A LAWSUIT IN THAT CONTEXT, AND IT'S NOT A LAWSUIT TO GET RICH. IT'S A LAWSUIT TO BRING MORE TRANSPARENCY AND ACCOUNTABILITY. AND SO, I WOULD ASK YOU TO CONSIDER PEOPLE WHO ARE FIGHTERS FOR THE PUBLIC. 

HILDA SOLIS, CHAIR: THANK YOU. NEXT SPEAKER? 

TANISHA DENARD: HELLO, MY NAME IS TANISHA. I'M WITH THE YOUTH JUSTICE COALITION. I'D LIKE TO URGE THAT YOU DO TAKE THE COMMUNITY'S RECOMMENDATION INTO CONSIDERATION, BECAUSE I FEEL LIKE WE HAVE TO BREAK THE NORM OF JUST KEEPING LAW ENFORCEMENT AND BREAK THE NORM OF WHAT WE'VE BEEN DOING IN THE PAST, BECAUSE IT REALLY HASN'T BROUGHT ANY REAL CHANGE WITHIN OUR COMMUNITY. SO, I FEEL THAT WE NEED TO INCLUDE THE COMMUNITY, PEOPLE THAT HAVE BEEN THROUGH IT AND KNOW WHAT WE NEED AND BREAK THE NORM AND CREATE A NEW CYCLE SO THAT WE CAN CREATE REAL PROGRAMS THAT, YOU KNOW, DIVERT THE PEOPLE THAT DON'T EVEN HAVE TO BE IN JAIL AND SO WE CAN TALK ABOUT MORE CONVERSATION ABOUT PREVENTING PEOPLE FROM GOING TO JAIL FOR A MINOR CRIME SO THAT MOST OF OUR JAILS WON'T EVEN BE OVERCROWDED AND A LOT OF THE CORRUPTION WOULDN'T BE GOING ON. AND SO, JUST ONCE AGAIN, I WOUDL JUST ENCOURAGE YOU TO TAKE INTO RECOMMENDATION THE COMMUNITY'S CONCERNS AND ALSO TO RETHINK HAVING LAW ENFORCEMENT IN THAT GROUP. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU. NEXT SPEAKER? 

ARNOLD SACHS: YES, THANK YOU. GOOD MORNING. ARNOLD SACHS. AND IT'S FASCINATING. REALLY. THERE WAS A STORY IN THE NEWSPAPER YESTERDAY, A COUPLE DAYS AGO ABOUT A MEETING AT THE POLICE COMMISSION IN L.A. CITY AND HOW THE COMMISSIONERS WERE UPSET BECAUSE SUPPOSEDLY THE INSPECTIONS OF THE PRISONERS WASN'T OCCURRING AT AN ASTOUNDING 82 PERCENT OF THE TIME. COMMISSIONERS WERE CONCERNED ABOUT THAT. AND THE UNION HEAD SAID BUT AT THE TIME THAT IT WAS OCCURRING, ALL THE PRISONERS WERE SAFE. BUT THE PART THAT WAS EVEN MORE FASCINATING WAS THAT THE OFFICERS WHO WERE SUPPOSED TO BE DOING THE INSPECTIONS WERE SUBMITTING FALSE REPORTS. NOBODY IS CONCERNED ABOUT THE FALSE REPORTS AND HOW THAT AFFECTS THE POLICING OF THE COMMUNITY AND THE OVERALL CONTEXT OF POLICING. AND SO, WHO APPOINTS THE POLICE COMMISSIONERS IN THE CITY OF L.A.? WELL, THEY'RE APPOINTED BY THE CITY, THE MAYOR. AND SO, WHO APPOINTS THE COMMISSIONERS FOR THE SHERIFF'S DEPARTMENT FOR THIS OVERSIGHT COMMISSION? WELL, THE COUNTY BOARD OF SUPERVISORS. AND THE COUNTY BOARD OF SUPERVISORS NEGOTIATES WITH THE SHERIFFS ON THE CONTRACTS. NOT "THE" SHERIFF, BUT THE SHERIFF'S UNION ON THE CONTRACT. THE SHERIFF IS LEFT OUT OF THAT. SO, WHEN YOU HAD THAT LITTLE DIVERSION THERE, THEN YOU HAVE A BIG DIVERSION. AND WHEN PEOPLE DON'T WANT TO ADDRESS THAT FACT, THEN THEY'RE JUST BLOWING SMOKE. IT'S LIKE PORTER RANCH, ONLY WORSE. IT'S THE CITY. NO, IT'S THEM. NO, IT'S THIS. AND THE FACILITIES? PERMANENT SUPPORTIVE HOUSING? WHY DON'T YOU LOOK INTO BUILDING SOME MENTAL-HEALTH FACILITIES? 

ATTORNEY: SIR, YOU'RE OFF TOPIC. YOU'RE UP HERE ON ITEM NO. 12. 

ARNOLD SACHS: OH, WOULD YOU TAKE A PILL? 

ATTORNEY: YOU'RE NOT TALKING ABOUT ITEM 12 AT THIS POINT. 

ARNOLD SACHS: THAT'S ANOTHER SITUATION. 

ATTORNEY: SIR, YOU'RE OFF TOPIC. 

HILDA SOLIS, CHAIR: OKAY. LET'S MOVE ON. OKAY. MEMBERS, THIS ITEM IS BEFORE US. IT'S MOVED BY SUPERVISOR KUEHL, SECONDED BY SOLIS, WITHOUT OBJECTION. WE ARE NOW GOING TO TURN TO ITEM R-2, WHERE WE WILL HAVE A PRESENTATION ON THE INTEGRATED HEALTHCARE DEPARTMENT, AND WE HAVE SEVERAL SPEAKERS. 

LORI GLASGOW, EXEC. OFCR.: YES, MADAME CHAIR, THE FOLLOWING INDIVIDUALS WILL NOW PRESENT TO THE BOARD, DR. MITCH KATZ DIRECTOR OF THE HEALTH AGENCY, ROBIN KAY, ACTING DIRECTOR OF MENTAL HEALTH, AND CYNTHIA HARDING, INTERIM PUBLIC HEALTH DIRECTOR. 

DR. MITCHELL KATZ: GOOD MORNING, MADAM CHAIR, MEMBERS. DR. MITCH KATZ. I'M THE DIRECTOR OF THE LOS ANGELES HEALTH AGENCY AND I'M VERY PROUD TO BE JOINED BY CYNTHIA HARDING, THE INTERIM DIRECTOR OF THE DEPARTMENT OF PUBLIC HEALTH, AND DR. ROBIN KAY, THE ACTING DIRECTOR OF THE DEPARTMENT OF MENTAL HEALTH. WE HAVE A POWERPOINT WHICH IS COUNTING ITSELF DOWN TO YOU. WE WANTED, AS A WAY OF PEOPLE UNDERSTANDING OUR WORK, WE WANTED TO ARTICULATE A PARTICULAR MOTTO FOR US AS A SHORTHAND FOR OUR MISSION, WHICH YOU'VE SEEN BEFORE. WE'VE CHOSEN, "WORKING TOGETHER FOR A HEALTHIER L.A." AND YOU CAN ALSO SEE THAT IN THIS NEXT VISUAL PRESENTATION, WHICH IS TO SHOW HOW WE DO OUR WORK. AND THIS IS A QUESTION THAT WE GET ASKED A LOT, SORT OF, WHAT'S THE SPECIAL SAUCE OF THE AGENCY? THE AGENCY DOES NOT HAVE ANY SEPARATE BUDGET. THE AGENCY DOES NOT HAVE SEPARATE STAFF THAT ARE NEW. AND THAT WAS DELIBERATE. THE GOAL HERE WAS NOT TO BUILD A NEW BUREAUCRACY OR ADD ADMINISTRATIVE COSTS. THE GOAL OF THE AGENCY WAS TO TAKE WHAT WE HAD AND BE ABLE TO PRODUCE MORE HEALTH, BETTER HEALTH OUTCOMES FOR OUR COMMUNITY. AND SO, I THINK THE VISUAL HELPS TO SAY THAT YOU AS A BOARD HAVE ARTICULATED EIGHT STRATEGIC PRIORITIES FOR US. WELL, AGAIN, OUR GOAL WAS NOT TO CREATE A BUDGET AND A STAFFING FOR EACH OF THOSE. OUR GOAL WAS TO SAY, WHAT ARE THE TOOLS THAT WE WOULD USE TO ACCOMPLISH THOSE PRIORITIES? AND THEY ARE THINGS LIKE TRAINING AND HOW WE DO OUR WORK AND REFER TO ONE ANOTHER; HOW WE REGISTER ACROSS OUR DIFFERENT SITES SO THAT ONCE SOMEONE HAS REGISTERED AT ONE SITE, THEY ARE REGISTERED IN ALL SITES; HOW WE USE COMMUNITY-BASED RESOURCES THAT SOMETIMES ONE OF THE THREE DEPARTMENTS HAS A GREAT WORKING RELATIONSHIP WITH AND THE OTHER TWO ARE NOT USING THAT RESOURCE IN QUITE AS EFFECTIVE A WAY. WE USE CASE MANAGEMENT AND CARE COORDINATION SO THAT WHEN SOMEONE IS BEING SEEN BY THREE OF THE DIFFERENT DEPARTMENTS, WE ARE NOW COORDINATING THEIR WORK. WE USE OUR DATA ANALYSIS AND OUR PLANNING CAPABILITIES. WE USE OUR HOUSING RESOURCES TOGETHER. AND WE IMPROVE OUR INFORMATION TECHNOLOGY RESOURCES SO THAT WE CAN ACCOMPLISH MORE WITH WHAT WE HAVE. AND WITH THAT, OUR GOAL IS TO IMPROVE THE QUALITY OF OUR SERVICES, TO INCREASE THE EFFICIENCY, TO DECREASE CHRONIC DISEASES, TO REDUCE HEALTH DISPARITIES, REDUCE HOMELESSNESS, REDUCE INCARCERATIONS, AND ENSURE THE FINANCIAL STABILITY OF THE OVERALL ENTERPRISE. THIS IS RUN THROUGH THE SAME EIGHT ACTIVITIES AGAIN AND THE EIGHT OUTCOMES. TODAY'S PRESENTATION IS FOCUSED ON METRICS. ANOTHER IMPORTANT REALIZATION WE HAD IN PREPARING THIS TALK AND WORKING WITH YOUR BOARD DEPUTIES IS THAT THE AGENCY IS A HUGE UNDERTAKING. WE'RE PLEASED THAT YOU ARE -- WOULD LIKE TO HAVE QUARTERLY REPORTS. BUT WE DON'T WANT TO BE IN A POSITION WHERE, WELL, THREE MONTHS IS NOT ACTUALLY THAT LONG A PERIOD OF TIME. WE'RE NOT GOING TO END HOMELESSNESS IN THREE MONTHS. WE'RE NOT GOING TO DECREASE SUBSTANCE USE NECESSARILY IN THREE MONTHS. WE MIGHT MAKE PROGRESS ON THOSE ISSUES. BUT WE ALSO DIDN'T WANT THIS TO BE A SIMPLY NUMERIC, OKAY, WELL, NOW WE'VE HOUSED 70 MORE PEOPLE SINCE YOU LAST SAW IT. WE THOUGHT WHAT WE WOULD TRY INSTEAD IS TO DEVELOP THESE PRESENTATIONS MORE THEMATICALLY. AND TODAY'S THEME IS METRICS DEVELOPMENT, SOMETHING THAT YOUR OFFICES HAVE ASKED ABOUT, SOMETHING THE COMMUNITY RIGHTFULLY ASKS ABOUT, OFTEN IN THE FORM OF, HOW DO WE KNOW IF THE AGENCY IS WORKING? HOW WOULD WE TELL IF THIS WAS A SUCCESSFUL UNDERTAKING? AND SO, WE HAVE WORKED WITH OUR VARIOUS STAKEHOLDERS IN THE INTEGRATION ADVISORY BOARD. AND WE'RE PREPARED TODAY TO GIVE YOU, IN SOME CASES, SPECIFIC EXAMPLES OF METRICS THAT WE'RE DOING, AND IN A FEW OTHER CASES, SHOW YOU WHERE WE'RE STILL WORKING ON EXACTLY WHAT THE BEST METRIC IS. SO, LET'S START WITH HOMELESSNESS. SO, THE AGENCY TAKES A VERY STRONG VIEW THAT HOMELESSNESS IS A CURABLE CONDITION, CURABLE BY HOUSING, AND THAT WHEN WE HOUSE PEOPLE, WE WILL SEE MARKED REDUCTIONS IN EMERGENCY DEPARTMENTS AND INPATIENT USE AFTER PEOPLE HAVE BEEN HOUSED FOR A PERIOD OF TIME. AND WE WANT TO ACHIEVE A 50-PERCENT REDUCTION. AND THAT LEVEL OF REDUCTION WILL THEN, IN TURN, HELP TO PAY FOR OUR ONGOING EFFORTS AT HOUSING PEOPLE. WE WANT 90 PERCENT OF PEOPLE WHO WE HOUSE TO BE RETAINED IN HOUSING AT 12 MONTHS. WE WANT TO ADD ANOTHER 2,500 SLOTS BY 2016, AND WE WANT TO CONNECT 90 PERCENT OF HOUSED INDIVIDUALS TO APPROPRIATE SERVICES. SO, WE ARE SETTING THIS AS OUR SET OF METRICS AROUND MEETING YOUR OBJECTIVE AROUND HOUSING. CYNTHIA HARDING IS GOING TO TALK ABOUT HOW WE'RE GOING TO MEASURE OURSELVES IN CHRONIC DISEASE AND INJURY PREVENTION. 

 CYNTHIA HARDING: THANK YOU, DR. KATZ, AND GOOD MORNING. SO, AS YOU SEE HERE ON THE SCREEN, THE OVERALL OBJECTIVE OF OUR CHRONIC DISEASE AND INJURY PREVENTION STRATEGIC PRIORITY IS TO LINK AND ALIGN THE WORK THAT WE'RE DOING WITHIN THE CLINIC WALLS WITH THE WORK THAT WE'RE PROMOTING IN POPULATION HEALTH, SO THAT WE CAN ENSURE THAT OUR CLIENTS ARE BENEFITING FROM HIGH- QUALITY CHRONIC-DISEASE MANAGEMENT IN CLINICS AND LINKING THEM TO SERVICES SO THAT THEY CAN THRIVE AND BE SAFE IN HEALTHY COMMUNITIES. AND THERE ARE A NUMBER. SO, YOU CAN SEE UP HERE, WE ARE WORKING ON TOBACCO-USE PREVENTION AND REDUCTION, OBESITY REDUCTION AND REDUCING CHRONIC DISEASES THAT ARE RELATED TO OBESITY, AND THEN REDUCING THE NUMBER OF VIOLENCE-RELATED EMERGENCY-ROOM VISITS IN THOSE COMMUNITIES WHERE WE'RE IMPLEMENTING OUR PARKS-AFTER-DARK PROGRAM. WE HAVE A NUMBER OF INITIATIVES UNDERWAY TO SUPPORT OUR WORK TO ACHIEVE THESE METRICS. WE ARE, FOR EXAMPLE, SCALING UP A CHRONIC-DISEASE PREVENTION-AND-MANAGEMENT PROGRAM THROUGH THE NATIONAL DIABETES PREVENTION PROGRAM, AND IT ALLOWS, IT'S A LINK BETWEEN OUR CLINICS AND REFERRING PEOPLE THAT WE FIND THROUGH O.R.C.H.I.D. OUR PREDIABETES TO A Y.M.C.A. PROGRAM, WHICH REDUCES THEIR ABILITY TO GET DIABETES. AND THEN WE'RE ALSO MAKING SURE THAT WE HAVE ACCESS TO EVIDENCE-BASED TOBACCO-CESSATION TREATMENT PROGRAMS IN OUR CLINICS. OUR THEN, OUR PARKS-AFTER-DARK PROGRAM, WE'RE GOING TO BE EXPANDING IT TO 21 PARKS THIS SUMMER IN PARTNERSHIP WITH THE PARKS AND REC DEPARTMENT. AND IT'S BEEN A VERY SUCCESSFUL PROGRAM TO REDUCE VIOLENCE IN COMMUNITIES WHERE WE BRING RESOURCES TO THE PARKS. WE HAVE SPECIFIC PROGRAMMING AROUND WE HAVE PHYSICAL ACTIVITY AND OTHER KINDS OF ACTIVITIES. AND IT'S BEEN VERY, VERY SUCCESSFUL IN THE COMMUNITIES. WE LOOK FORWARD TO EXPANDING IT THIS SUMMER. 

DR. MITCHELL KATZ: THAT'S GREAT. ONE OF THE AREAS THAT I'M MOST EXCITED ABOUT THAT DR. KAY IS GOING TO DESCRIBE IS OUR SUCCESSFUL EFFORTS TO REDUCE PSYCHIATRIC EMERGENCY DEPARTMENTS. AND I WOULD JUST SAY, HAVING WALKED THROUGH ALL OF OUR PSYCHIATRIC EMERGENCY DEPARTMENTS, WE REALLY DO NOT WANT PEOPLE TO BE IN THOSE AREAS UNLESS THEY ABSOLUTELY HAVE TO. PSYCHIATRIC EMERGENCY DEPARTMENTS HAVE AN IMPORTANT ROLE FOR PEOPLE WHOSE BEHAVIOR IS SO BEYOND THEIR ABILITY TO CONTROL THAT THEY HAVE TO BE IN AN INCREDIBLY SECURE ENVIRONMENT WITH LOCKED DOORS AND DOUBLE WINDOWS AND, SADLY, SOMETIMES RESTRAINTS. BUT WHAT WE DO NOT WANT IS SOMEBODY WHO IS IN CRISIS BUT WHO IS NOT AT THAT LEVEL OF RISK SUBJECTED TO THE LEVEL OF TRAUMA THAT I THINK CAN OCCUR BY BEING IN A PSYCHIATRIC EMERGENCY DEPARTMENT. AND I THINK DR. KAY AND HER DEPARTMENT'S EFFORTS HAVE BEEN ALREADY HELPFUL IN THAT AREA. 

DR. ROBIN KAY: THANKS, DR. KATZ. SO, A NUMBER OF YEARS AGO, YOUR BOARD DIRECTED THE DEPARTMENT OF MENTAL HEALTH AND THE DEPARTMENT OF HEALTH SERVICES TO WORK TOGETHER TO ADDRESS OVERCROWDING IN THE PSYCHIATRIC EMERGENCY ROOMS. AND WE WANTED TO DEVELOP A STRATEGY FOR ENSURING THAT INDIVIDUALS, AS DR. KATZ JUST MENTIONED, WHO ARE IN A MENTAL HEALTH CRISIS COULD RECEIVE SERVICES IN A SETTING THAT WAS BEST SUITED TO THEIR NEEDS. SO, THE DEVELOPMENT OF THE MENTAL HEALTH URGENT CARE CENTERS HAVE FORMED THE CORE OF THAT EFFORT. WE HAVE FOUR ACROSS THE COUNTY NOW, AND WE'LL DOUBLE THAT NUMBER IN THE YEAR TO COME. THIS IS ONE AREA IN WHICH THE AGENCY HAS NOT ONLY IDENTIFIED METRICS BUT CAN ALSO SHOW SOME RESULTS. ON SLIDE 9, YOU SEE THE PROPOSED METRICS DECREASING THE NUMBER OF DAYS, OF COURSE, THAT THE COUNTY'S PSYCHIATRIC EMERGENCY ROOMS ARE ABOVE CAPACITY. THE SECOND REFLECTS THE FACT THAT WHEN THERE'S NO FLOW OF PATIENTS OUT OF THE INPATIENT UNITS IN THE D.H.S. HOSPITALS, THEN THERE'S A BACKUP IN THE EMERGENCY ROOMS. AND SO, IN ORDER TO REDUCE THE OVERCROWDING OF THE PSYCHIATRIC EMERGENCY DEPARTMENTS, WE ALSO HAVE TO FOCUS ON WHAT HAPPENS FARTHER DOWN IN THAT CONTINUUM AND WORK ON DECOMPRESSING THE INPATIENT UNITS, AS WELL, TO AVOID GRIDLOCK. AND THEN FINALLY, AS WE CONTINUE TO FOCUS ON INCREASING URGENT- CARE VISITS AND RELIANCE ON THE COMMUNITY-BASED MENTAL-HEALTH URGENT-CARE CENTERS, WE WOULD EXPECT TO SEE THE UTILIZATION OF THOSE URGENT CARE CENTERS INCREASE AND THE UTILIZATION OF THE PSYCHIATRIC EMERGENCY ROOMS DECREASE. AND ACTUALLY, HERE'S THE GOOD NEWS, SO, ON SLIDE 10, WHAT YOU SEE IS THE INCREASING USE OF THE MENTAL-HEALTH URGENT-CARE CENTERS. SO, AS THE COMMUNITY BECOMES AWARE OF THE URGENT-CARE CENTERS, AS THE D.H.S. HOSPITALS INCREASINGLY TRANSFER CLIENTS TO THE MENTAL-HEALTH URGENT-CARE CENTERS, AND AS LAW ENFORCEMENT BEGIN TO INCREASINGLY SEE THESE FACILITIES AS A RESOURCE, THE NUMBER OF VISITS HAS GONE UP. AND HERE'S THE EVEN BETTER NEWS. TA-DAH! SO, AS THE USE OF THE MENTAL-HEALTH URGENT-CARE CENTERS HAS GONE UP, WE HAVE SEEN A CONCOMITANT DECREASE IN THE USE OF THE PSYCHIATRIC EMERGENCY DEPARTMENTS. 

SUP. KNABE: MADAME CHAIR, CAN I JUST FOLLOW-UP ON THAT? HOW IS THAT RELATING TO -- YOU KNOW, ONE OF THE THINGS THAT WE'VE HAD IS THE LONG WAITS FOR PARAMEDICS AND SHERIFF DEPUTIES AND POLICE OFFICERS AND THE WAIT TIMES ON THESE PSYCHIATRIC ISSUES. IS THAT HAVING AN IMPACT ON THAT, AS WELL, BY HAVING THESE URGENT CARE? 

DR. MITCHELL KATZ: YES, SUPERVISOR. IN THE HOSPITALS, BECAUSE ONCE WE GET TO A LEGAL CAPACITY, I CAN'T BRING MORE PEOPLE IN. AND IT'S NOT EVEN -- IT WOULDN'T EVEN HELP ME IF I HAD MORE STAFF, BECAUSE I JUST DON'T HAVE THE PHYSICAL ROOM. SO, THE BACKUP IS CAUSED WHEN EVERY SPACE IN THOSE EMERGENCY ROOMS ARE AT CAPACITY AND IT BECOMES UNSAFE TO BRING SOMEBODY IN. SO TO THE EXTENT, I MEAN, WE HAVE MADE HUGE PROGRESS. THERE'S MORE PROGRESS TO BE MADE AS WE LIMIT THOSE EMERGENCY DEPARTMENTS TO PEOPLE WHO HAVE TO BE IN THAT LEVEL OF CARE, THEN PEOPLE WILL -- THERE WILL BE EMPTY ROOM AND PEOPLE WILL JUST BRING PATIENTS IN. WE HAVE NO NEED TO WAIT. WE WILL BRING SOMEONE WITH A PARAMEDIC OR POLICE OFFICER IN AS LONG AS THERE'S AN EMPTY ROOM. SO, YES, WE'LL DO IT. AND I'LL LOOK AT -- I THINK -- 

SUP. KNABE: IT'S A METRIC THAT SHOULD BE BE CONSIDERED. 

DR. MITCHELL KATZ: E.MS. YEAH. I'LL LOOK TO SEE HOW WE -- WHAT OUR ABILITY TO TRACK THAT IS. I'LL FIGURE OUT -- WE'LL FIGURE OUT A WAY TO TRACK IT. THANK YOU, SUPERVISOR. THAT'S A GREAT POINT. 

HILDA SOLIS, CHAIR: SUPERVISOR KUEHL, YOU HAD A QUESTION ON THAT? OKAY. YOU WANT TO JUST FINISH? OKAY. 

DR. MITCHELL KATZ: BACKWARDS OR FORWARD, SUPERVISOR? OKAY. VERY GOOD. THANK YOU. THANK YOU, SUPERVISOR. SO, WE'RE EXCITED TO PRESENT THESE TO YOU. AND I HOPE YOU HEAR, AS ALL THREE OF US SPEAK, YOU HEAR ELEMENTS OF THE DIFFERENT PARTS OF THE AGENCY. YOU HEAR CYNTHIA TALKING ABOUT THE RELATIONSHIP BETWEEN THE PREVENTION THAT GOES ON IN THE CLINIC WALLS AND THE PREVENTION THAT GOES ON IN THE COMMUNITY. AND YOU HEAR DR. KAY SPEAKING ABOUT THE RELATIONSHIP BETWEEN THE OUTPATIENT SERVICES TRADITIONALLY PROVIDED BY DEPARTMENT OF MENTAL HEALTH AND THE INPATIENT SERVICES TRADITIONALLY BY D.H.S. AND CERTAINLY HOUSING REQUIRES THE SERVICES OF SUBSTANCE TREATMENT, WHICH IS IN PUBLIC HEALTH, MENTAL HEALTH SERVICES, AS WELL AS THE PHYSICAL HEALTH SERVICES. WE LOOK FORWARD TO WORKING WITH YOU ON FURTHER METRICS. WE'RE PLEASED THAT THE WORKING TOGETHER, INCLUDING IN DEALING WITH SOME OF THE MAJOR PUBLIC HEALTH CRISES, HAVE BEEN SUCCESSFUL. WE'RE WORKING ON OUR WEBSITE SO THAT -- ALL THREE DEPARTMENTS ALREADY HAVE A WEBSITE, BUT NOW WE'RE WORKING ON AN AGENCY WEBSITE THAT WILL ENABLE PEOPLE TO SEE THE VALUE OF ALL OF US WORKING TOGETHER. SO, LOTS OF GOOD WORK DONE, AND A LOT MORE TO DO IN THE FUTURE. THANK YOU VERY MUCH. 

HILDA SOLIS, CHAIR: SUPERVISOR KUEHL? 

SUP. SHEILA KUEHL: THANK YOU VERY MUCH, MADAME CHAIR. I HAVE SEVERAL QUESTIONS. SO, LET ME GO, IF I MAY, FROM THE MICRO TO THE MACRO. FIRST OF ALL, I THINK THE CHOICE TO PRESENT PROPOSED METRICS OR METRICS AGAINST WHICH WE WILL MEASURE ON THREE OF THE EIGHT CATEGORIES, IT'S VERY HELPFUL TO US, BECAUSE I THINK OFTEN WHEN WE SEE EVERYTHING COMING AT US AT ONCE, IT RAISES SO MANY QUESTIONS, IT'S HARD FOR US TO FOCUS. BUT MY QUESTION, I GUESS, WOULD BE: IS IT YOUR INTENTION, THEN, IN THREE MONTHS TO TALK ABOUT THREE OTHER OF THE EIGHT GOALS, AND THEN IN THREE MONTHS, TWO OTHER OF THE EIGHT GOALS, ALL IN THE SENSE OF SETTING METRICS? OR IS IT YOUR INTENTION, IN ADDITION, TO REPORT BACK, AS YOU'VE SAID, A COUPLE OF THESE GOALS ARE MEANT TO BE ACHIEVED OR HOPEFULLY ACHIEVED THIS YEAR. HOW WILL WE KNOW THOSE MEASUREMENTS AS YOU PREPARE THE NEXT ONES TO COME? 

DR. MITCHELL KATZ: SUPERVISOR, SO, THANK YOU. AND WE AS A LEADERSHIP TEAM, WE'RE OPEN AT THIS POINT. SO A LOT OF THIS IS WE ARE INVENTING IT WITH YOU AS WE MOVE ALONG. SO, WE DO HAVE METRICS IN THE APPENDIX FOR THE OTHER FIVE. WE DIDN'T WANT THE VISUAL TO BE, YOU KNOW, ALL EIGHT, FOR THE REASONS THAT YOU SAY. SO WE DO HAVE THEM. IN SOME CASES, FOR EXAMPLE, ON THE METRICS ON QUALITY, WE'RE STILL WORKING. WE KNOW WE WANT TO MEASURE QUALITY OF SERVICES, BUT WE'RE NOT YET SURE EITHER WHICH MEASURE WE'RE GOING TO USE OR WHAT PERCENT WE THINK WOULD BE THE APPROPRIATE INCREMENT. SO, IT IS PART OF YOUR WHOLE PACKET, AND WE'RE GOING TO SEE HOW TODAY WENT AND THEN MAKE A DECISION AS TO HOW TO PROCEED WITH THE REST. 

SUP. SHEILA KUEHL: WELL, LET ME TALK ABOUT THE THREE AREAS THAT YOU CHOSE. IN TERMS OF THE PSYCHIATRIC EMERGENCY SERVICES, WE WERE CONCERNED OVER VARIOUS POINTS OF TIME ABOUT HOW FIRST RESPONDERS WERE BEING TRAINED, OR NOT, TO BRING PEOPLE WHO THEY HAD DETAINED FOR SERVICES INSTEAD OF BRINGING THEM DIRECTLY TO THE JAILS. AND I WONDER HOW THAT TRAINING IS BEING SHARED, IF IT IS, AND HOW IT'S GOING. 

DR. ROBIN KAY: SO, THERE ARE TWO CASES TO THAT. FIRST OF ALL, AS WE BRING UP NEW URGENT CARE CENTERS, WE DO TRAINING OF ALL THE LOCAL LAW ENFORCEMENT PROVIDERS IN THE VICINITY OF THE URGENT CARE CENTER, BECAUSE THERE'S A GEOGRAPHIC NATURE TO THIS. WE WANT LAW ENFORCEMENT OBVIOUSLY TO BRING PEOPLE TO THE MENTAL-HEALTH URGENT-CARE CENTER THAT IS CLOSEST TO WHERE THEY'RE DETAINING THEM OR PICKING THEM UP. SO, WHAT WE'VE SEEN IS THIS SLOW BUT STEADY INCREASE IN THE NUMBER OF LAW ENFORCEMENT PERSONNEL THAT ARE NOW BRINGING PEOPLE TO A MENTAL-HEALTH URGENT-CARE CENTER WHEN THEY'RE SUSPECTED OF HAVING A MENTAL-HEALTH ISSUE, IN LIEU OF A HOSPITAL EMERGENCY ROOM. I DON'T HAVE THE DATA HERE TODAY, BUT WE CAN CERTAINLY PRODUCE THAT. WE DID COLLECT IT. 

SUP. SHEILA KUEHL: WELL, I GUESS I'M INTERESTED IN THE TRAINING, BECAUSE SO OFTEN WE RELY ON LAW ENFORCEMENT, FIRST RESPONDERS, PUBLIC SAFETY TO MAKE AN ASSESSMENT THEY'RE NOT TRAINED TO MAKE, IN A SENSE. SHALL I BRING THIS PERSON TO AN EMERGENCY PSYCHIATRIC CENTER, BECAUSE IN MY OPINION, YOU KNOW, THEY'RE NEEDED, OR, YOU KNOW, THEY'RE JUST ACTING A LITTLE CRAZY LIKE ALL CRIMINALS; I'LL TAKE HIM TO JAIL. HOW ARE YOU WORKING WITH THEM TO DISTINGUISH? 

DR. ROBIN KAY: SO, THERE ARE A NUMBER OF DIFFERENT STRATEGIES. FIRST OF ALL, THE C.I.T. TRAINING, WHICH IS A LITTLE DIFFERENT FOR SHERIFF'S DEPARTMENT AND THE LOCAL LAW ENFORCEMENT AGENCIES. THE DEPARTMENT OF MENTAL HEALTH IS PROVIDING THE MENTAL HEALTH TRAINING FOR L.A.P.D. LARGELY, NOT SOLELY, BUT FOR L.A.P.D., AND IN COLLABORATION WITH THE DISTRICT ATTORNEY FOR MANY OF THE SMALLER CITY POLICE DEPARTMENTS. AND THAT TRAINING IS UNDERWAY. IT'S ACTUALLY GOING WELL. IT'S OBVIOUSLY A MULTI-YEAR EFFORT, BUT WE'VE DONE QUITE A BIT OF TRAINING BOTH BEFORE THIS YEAR AND ALSO EXPANDED THIS YEAR. WE ALSO, SECOND STRATEGY IS OUR EMBEDDING OF MENTAL HEALTH PERSONNEL ON THOSE CO-RESPONSE TEAMS WITH LAW ENFORCEMENT. PROBABLY THE MOST PROGRESSIVE PROGRAM RIGHT NOW IS THE ONE OPERATED BY L.A.P.D., BECAUSE THEY HAVE A SYSTEM FOR INSURING THAT WHENEVER THERE'S A SUSPICION THAT SOMEONE HAS A MENTAL HEALTH ISSUE, THERE IS A CALL CENTER THAT ALLOWS OFFICERS WHO ARE PATROL OFFICERS TO GAIN ACCESS TO CONSULTATION PROVIDED BY THEIR STAFF AS WELL AS MENTAL HEALTH STAFF EMBEDDED AT THEIR CENTRAL OPERATIONS UNIT. AND ALSO, WE HAVE THE TEAMS OF -- THEY CAN CALL A TEAM, WHICH IS COMPOSED OF A LAW ENFORCEMENT OFFICER AND MENTAL HEALTH CLINICIAN FROM THE DEPARTMENT OF MENTAL HEALTH THAT WILL GO OUT AND DO THE EVALUATION OF PEOPLE IN THE FIELD WHEN THERE'S A SUSPECTED ISSUE RELATED TO MENTAL HEALTH. 

SUP. SHEILA KUEHL: I THINK WE'D PROBABLY BE INTERESTED IN KNOWING WHETHER IT'S POSSIBLE TO BREAK OUT, IN TERMS OF REPORTING TO US, PEOPLE WHO ARE REFERRED TO THE PSYCHIATRIC CENTERS BY LAW ENFORCEMENT OR NOT AND IF THERE IS SOME CHANGE BECAUSE OF THIS TRAINING. THE SECOND THING IS, I'M MOST INTERESTED PERSONALLY IN THIS -- ALL THE AREAS OF INTEGRATION. AND IN TERMS OF TALKING ABOUT THE SUPPORTIVE SERVICES FOR THOSE WE'RE PLACING IN HOUSING, WHICH IS A SECOND OF THE CATEGORIES, IT SEEMS TO ME THAT THERE ARE TWO VERY DIFFERENT SYSTEMS OPERATING IN THE COUNTY AROUND SUPPORT FOR OUR HOMELESS POPULATION BEING HOUSED, BECAUSE D.M.H. HAS A SYSTEM AND D.H.S. HAS A SYSTEM. AND I DON'T KNOW -- I WOULD LOVE TO KNOW WHAT THE PLAN IS FOR BRINGING THOSE SOMEHOW TOGETHER SO THAT WHEN WE'RE LOOKING AT METRICS, WE'RE KIND OF SEEING. I DON'T KNOW WHETHER D.M.H., FOR INSTANCE, HAS SET METRICS FOR THEIR SUPPORTIVE SERVICES FOR HOMELESS. I THINK D.H.S. HAS. SO, I'D LIKE TO KNOW MORE ABOUT PROPOSED INTEGRATION IN THAT, IN THE SUPPORTIVE SERVICES FOR HOMELESS PEOPLE. 

DR. MITCHELL KATZ: WE'LL PREPARE THAT. 

SUP. SHEILA KUEHL: OKAY, BECAUSE I THINK WHEN TALKING ABOUT PUTTING SOMETHING IN AN AGENCY, THIS WAS OUR FANTASY, THAT THERE WOULD BE INTEGRATION. AND I KNOW THAT WHERE THINGS ARE ALREADY HAPPENING, IN D.M.H., IN D.H.S., AND SOMETIMES NEVER THE TWAIN SHALL MEET AND SOMETIMES THERE'S A HOPE THAT THEY WILL. BUT IF WE'RE LOOKING AT METRICS, I'D LIKE TO SEE MAYBE THEY ARE ALL BEING MEASURED IN D.H.S. AND NOT SO MUCH IN D.M.H. OR VICE VERSA. FINALLY, I'D LIKE TO TALK A LITTLE MORE, IF I MAY, MORE GENERALLY ABOUT THIS INTEGRATION ISSUE AND WHAT I'D LIKE TO KNOW. YOU INDICATED THAT WE NOW ALLOW PEOPLE TO -- THEY COME IN, THEY'VE REGISTERED IN ONE SYSTEM, AND OUR GOAL IS TO MAKE SURE THEY'RE REGISTERED IN ALL OF OUR SYSTEMS. I WOULD LIKE THERE TO BE SOME KIND OF REPORT/MEASUREMENT ABOUT APPROPRIATE REFERRAL FROM ONE DEPARTMENT TO ANOTHER. IN OTHER WORDS, YOU COME -- YOU KNOW WHAT I MEAN, COME INTO MY DEPARTMENT, YOU GOT A BROKEN ARM, LOOKS TO ME YOU'RE SHOWING SIGNS OF SOME ADDICTION ISSUES. WE REGISTER YOU. OKAY, YOUR NAME'S IN THE SYSTEM FOR PUBLIC HEALTH, BUT DID ANYONE REFER YOU FOR SOME KIND OF HELP? AND IN A SENSE, THERE'S CROSS TRAINING THERE, TOO, BECAUSE MENTAL HEALTH PROFESSIONALS AREN'T ALWAYS TRAINED TO RECOGNIZE THAT SOMEONE HAS A HEAD INJURY, THOUGH THERE MAY BE A RELATIONSHIP THERE. SO, I GUESS I WANT TO ASK YOU AS YOU GO ALONG ABOUT APPROPRIATE REFERRALS AND IF WE CAN GET SOME DATA THAT THE LEFT HAND IS REFERRING TO THE RIGHT HAND NOW THAT WE'VE ASKED THEM ALL TO BE PART OF ONE SERVICE. THE FINAL THING I WANT TO ASK IS, IN THE NEXT REPORT, IF YOU HAVEN'T ALREADY DECIDED ON THE NEXT THREE AREAS, I PERSONALLY WOULD BE VERY INTERESTED IN THE CHILDREN'S AREA. AND I NOTICE THAT THE AREA IS CALLED "VULNERABLE CHILDREN." AND I GUESS IF THEY'RE TOUCHING THE COUNTY, FROM MY POINT OF VIEW, THEY'RE VULNERABLE. SO, NOT JUST OUR FOSTER KIDS, NOT JUST OUR KIDS WHO ARE BEING INCARCERATED, BUT CHILDREN WHO GET SERVICES IN ANY WAY FROM 0-5 TO ADOLESCENT MEDICINE OR WHATEVER, I THINK WE WOULD BE VERY INTERESTED TO KNOW, WHAT METRICS ARE YOU PROPOSING IN THAT AREA, NOT JUST FOR THESE SPECIFIC POPULATIONS THAT WE MIGHT CALL VULNERABLE BUT ALL THE CHILDREN BEING SERVED CURRENTLY BY THE COUNTY, BECAUSE SOME ARE JUST POOR, AND I DON'T KNOW IF THAT MAKES THEM VULNERABLE. I MEAN, I THINK IT MAKES THEM VULNERABLE, BUT I DON'T KNOW IF IT MAKES THEM DEFINED AS VULNERABLE. SO, THAT WOULD BE VERY HELPFUL. YOU MAY HAVE ALREADY DECIDED NOT TO DO CHILDREN NEXT. 

DR. MITCHELL KATZ: WE HAVEN'T, SUPERVISOR. WE WILL MAKE SURE THAT THEY'RE IN THE NEXT GROUP. AND I THINK WE DO UNDERSTAND VULNERABLE IN THE WAY YOU DO. 

SUP. SHEILA KUEHL: THANK YOU, MADAME CHAIR. 

HILDA SOLIS, CHAIR: I JUST WANT TO COMPLIMENT WHERE YOU'VE GONE SO FAR IN YOUR INTEGRATION, AND I'VE SEEN IT FIRSTHAND LAST WEEKEND. WE HAD AN EVENT OUT IN THE PICO, THE PACIFIC-UNION AREA REGARDING EXIDE. AND JUST TO SEE DEPARTMENT OF HEALTH SERVICES THERE, MY HEALTH L.A., U.S.C. DENTISTRY, YOU HAD WESTERN STATE UNIVERSITY THAT WAS DOING OPTOMETRY TESTS, YOU KNOW, OPTOMETRISTS WERE THERE, AND THEN TO HAVE PUBLIC HEALTH. THEY ACTUALLY TESTED ABOUT -- OVER 250 CHILDREN, MEN, AND WOMEN FOR LEAD POISONING AND IT WAS INCREDIBLE. AND IT WAS NONSTOP. AND I HAVE TO TELL YOU THAT THIS IS, I THINK, A CHAPTER THAT HAS TO BE WRITTEN THAT CAN BE SHARED WITH THE STATE, THE D.T.S.C., BECAUSE OF THEIR LACK OF CULTURAL FAMILIARITY IN JUST HOW TO ADDRESS OUR COMMUNITY. IT WAS THE FIRST TIME THAT I HEARD FROM MANY, MANY PEOPLE THAT SAID THAT THEY HAD NEVER BEEN INVOLVED IN ANYTHING LIKE THAT THROUGH THE COUNTY. SO, THAT SAYS A LOT. THAT ALSO TELLS ME THAT WE HAVE A LONG WAY TO GO, BECAUSE THAT WAS JUST ONE POINT ON THE GRID OF HOW MANY HOUSEHOLDS ARE IMPACTED BY EXIDE RIGHT NOW. BUT I WAS VERY, VERY PLEASED WITH THAT COOPERATION, AND I'D LIKE TO SEE MORE OF THAT HAPPEN. AND I KNOW WE'RE KIND OF JUST STUMBLING ALONG DOING IT THIS WAY AND IT'S TAKING A LONG TIME TO GET HERE AND IT TAKES A LOT OF TIME. SO I WANT TO THANK MS. HARDING AND EVERYONE, DR. KATZ AND MENTAL HEALTH FOLKS THAT WERE THERE, EVERYBODY THAT WAS ON THE GROUND. IT REALLY REQUIRES BOOTS ON THE GROUND IN THAT MANNER. SO, WHILE WE'RE MAYBE INSIDE OUR HEALTHCARE FACILITIES IS ONE THING, WHICH IS GOOD. BUT I'M ALSO VERY, VERY UNIQUE CONCERNED ABOUT WHAT OUR PRESENCE IS OUTSIDE OF THOSE DOORS. SO, WHEN WE'RE IN THE COMMUNITY, DO WE HAVE ENOUGH PEOPLE THAT ACTUALLY SPEAK THE LANGUAGE? DO WE HAVE INTERPRETERS ARE OUT THERE ON THE GROUND APPROPRIATELY PLACED? DO WE HAVE PROMOTORAS. AND THE NUMBER, I THINK, HASN'T INCREASED AS MUCH AS I'D LIKE TO SEE IT IN TERMS OF OUTREACH AND BEING ABLE TO INTEGRATE THAT WITH ALL OF THE AGENCIES HERE BEFORE ME. AND I THINK THAT GIVEN THE CONCERNS AND THE FACT THAT THE POPULATION THAT WE SERVE IS -- HAS CHANGED SO MUCH, THAT WE HAVEN'T KEPT UP WITH THAT PACE. SO, I WOULD LIKE TO SEE WHAT METRICS YOU HAVE MOVING FORWARD TO SEE THAT THAT'S IMPLEMENTED AND WHERE WE CAN FIND OTHER SOURCES OF FUNDING TO HELP COMPLEMENT THAT. BUT I THINK IT'S GOING TO BE REALLY IMPORTANT, ALSO, WHEN WE START LOOKING AT REALLY ENACTING OUR DIVERSION PROGRAMS AND LOOKING INSIDE THE JAILS, INSIDE PROBATION, AND THEN OUTSIDE AND WHO IS ALSO IN THERE TALKING TO THOSE INDIVIDUALS AND HAVING THAT KIND OF CULTURAL SENSITIVITY AND ALSO LINGUISTIC SENSITIVITY. AND I'M REALLY HOPEFUL THAT WE CAN SEE MORE IN THAT MANNER HAPPENING, SOME REAL NUMBERS. AND I DO WANT TO SAY THAT I AM ALSO EQUALLY CONCERNED ABOUT OUR CHILDREN AND MORE IMPORTANTLY IN TERMS OF THE MENTAL-HEALTH ASSESSMENTS THAT I THINK NEED TO OCCUR MORE AROUND THE CLOCK AT OUR PROBATION CAMPS, IN OUR JUVENILE JUSTICE HALLS, THAT I'M BECOMING MORE UNIQUELY AWARE OF THAT WE'RE LACKING, AND TO HAVE 24-HOUR SERVICES WHEN NEEDED SO WE DON'T HAVE TO SOMEHOW AT THE LAST MINUTE FIGURE OUT WHERE WE'RE GOING TO PLACE YOUNG PEOPLE BUT BE ABLE TO DO IT IN AN APPROPRIATE WAY AND UNDERSTAND THAT YOU CAN'T JUST SHOVE A CHILD AROUND HAPHAZARDLY AROUND IN A CAR FOR MANY HOURS AND NOT BE GIVEN A FULL ASSESSMENT AND DIAGNOSIS OF THAT CHILD'S WELL-BEING. SO, I CONTINUE TO BE CONCERNED, BECAUSE I THINK ABOUT THE HEALTHCARE THAT I GET. SO, WHEN I GO SEE MY DOCTOR, IT GOES ON THE COMPUTER, OR SHE DOES. EVERYTHING'S THERE. THEY KNOW EVERY TEST. THEY KNOW WHAT I HAVEN'T DONE. THEY KNOW WHAT MY WEIGHT SHOULD BE. THEY TELL ME EVERYTHING. AND I'M WONDERING: WHEN ARE WE GOING TO BE ABLE TO GET TO THAT POINT, AS WELL, SO THAT IF A CHILD COMES IN FROM SCHOOL MAYBE MISSES A COUPLE OF DAYS AND THEY COME IN AND WE FIND OUT THEY'RE SICK, OKAY, WHO'S LOGGING THAT? HOW DO WE GET IT TO OUR CLINICS? DID THE CLINIC SEND IT TO THE PROBATION OFFICER OR VICE VERSA, SO, WHEN ARE WE GOING TO SEE, WHERE WE CAN, IN TERMS OF PRIVACY, I UNDERSTAND THAT AND ALL THAT, BUT JUST KNOWING HOW WE CAN BETTER START TO TOOL UP IN THAT FASHION. SO, THAT'S A METRIC ALSO THAT I THINK IS VERY -- WE'VE TALKED ABOUT IT SO MANY TIMES, BUT I JUST THINK IT HAS TO CONTINUALLY BE SAID AND WE HAVE TO SPEND FUNDING TO DO IT. SO, I'M ABOUT TRYING TO FIGURE OUT HOW WE CAN GET HELP ALSO FROM OUR PARTNERS IN SACRAMENTO AND THE FEDERAL GOVERNMENT TO HELP US DO THAT. SO, ANY THOUGHTS ON THAT? DR. KATZ? 

DR. MITCHELL KATZ: THOSE ARE ALL GREAT THANKS, SUPERVISOR, AND I THINK IT'S WELL-CAPTURED IN YOUR FIRST OPENING STATEMENT, WHICH IS A LOT'S BEEN DONE BUT THERE'S A WHOLE LOT MORE TO DO. AND WE'RE PROUD OF WHAT WE'VE GOTTEN DONE, BUT WE KNOW THAT IT'S JUST A SMALL PART AND THAT WHAT YOU'RE REALLY TALKING ABOUT IS THE CONNECTEDNESS OF THINGS AND WHETHER OR NOT PEOPLE ARE ABLE TO CONNECT THE DOTS, ESPECIALLY ABOUT CHILDREN OR OTHER PEOPLE WHO ARE IN JAIL OR AT RISK AND MAKING SURE THAT THE SYSTEM UNDERSTANDS ALL THE PIECES. AND SOME OF THE FAILURES THAT HAVE OCCURRED HISTORICALLY HAVE BEEN BECAUSE PEOPLE HAD ONLY PARTIAL INFORMATION, DIDN'T UNDERSTAND ALL THAT'S GOING ON. AND, YOU KNOW, I FEEL WE'VE MADE GREAT PROGRESS, BUT I THINK YOUR OVERALL ASSESSMENT THAT THERE'S A LONG WAY TO GO IS TRUE. AND WE COMMIT TO YOU AND TO YOUR COLLEAGUES THAT WE'RE GOING TO KEEP WORKING HARD. AND WE UNDERSTAND THE DIRECTION OF THIS BOARD AND THE VALUES AND PRIORITIES OF THIS BOARD. AND WE'RE JUST GOING TO KEEP AT IT UNTIL IT'S THE SYSTEM THAT YOU WANT IT TO BE. 

HILDA SOLIS, CHAIR: WELL, I DO WANT TO APPLAUD THE THREE OF YOU AND YOUR STAFF AND THE ORGANIZATION THAT IS BEHIND YOU. AND OF COURSE, YOU HAVE MY SUPPORT. I DEFINITELY HAVE SEEN SOME MAJOR CHANGES AND HOPE TO BE ABLE TO SEE MORE AND BE ABLE TO STAND OUT, THE COUNTY, AS BEING A MODEL FOR THE COUNTRY IN SO MANY DIFFERENT WAYS. WE'RE DOING IT NOW, AND THANKS TO YOU AND THE LEADERSHIP THAT YOU'VE BEEN ABLE TO PULL TOGETHER, WE'RE GOING IN THE, I BELIEVE, IN THE RIGHT DIRECTION, BUT DEFINITELY WE NEED TO DO MORE. 

DR. MITCHELL KATZ: THANK YOU, SUPERVISOR. AND WE DO GET CALLS ALL THE TIME, AS YOU'RE SAYING, FROM PEOPLE IN OTHER LOCALITES ASKING HOW WE HAVE BEEN ABLE TO PULL THINGS TOGETHER. AND I WANT TO GIVE A SPECIAL SHOUTOUT TO MY DEPUTY DR. ALEX LI, WHO DID A LOT OF WORK IN PUTTING TOGETHER THIS PRESENTATION AND WHO GOES TO ALL THE DIFFERENT MEETINGS SO THAT THE WORK OF THE EIGHT DIFFERENT GROUPS AROUND THE EIGHT DIFFERENT PRIORITIES ITSELF CONNECTS AND WE DON'T RUN INTO PROBLEMS WHERE THEY'RE SEPARATE. 

HILDA SOLIS, CHAIR: VERY GOOD. THANK YOU. YES, SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: DR. KATZ, AS YOU'RE DOING THE INTEGRATION OF THE THREE DEPARTMENTS, HOW ARE YOU EVALUATING THE WORKING WITH THE OTHER COUNTY DEPARTMENTS LIKE D.P.S.S. AND THE OTHER NONPROFITS THAT WE PARTNER WITH? 

DR. MITCHELL KATZ: WELL, THANK YOU SO MUCH, MR. SUPERVISOR. THAT'S A GREAT QUESTION. I THINK WHAT'S HAPPENED IS WE HAVE DRAWN CLOSER TO THE OTHER DEPARTMENTS, IN PART BECAUSE NOW OUR OVERALL RESOURCES ARE STRONGER SO THAT WHEN IT COMES, FOR EXAMPLE, TO WORK WITH A DEPARTMENT LIKE D.P.S.S. OR PROBATION, WE CAN -- THEY HAVE CLIENTS WHO NEED SUBSTANCE ABUSE SERVICES THAT ARE DONE IN PUBLIC HEALTH, THAT NEED MENTAL-HEALTH SERVICES. THEY NEED PHYSICAL-HEALTH SERVICES. D.H.S. NOW DOES ALL OF THE GENERAL ASSISTANCE PHYSICAL EXAMINATIONS FOR D.P.S.S. AND SO, TOO, WITH THE COMMUNITY-BASED AGENCIES. NOW SOMETIMES IT WILL TURN OUT THAT MENTAL HEALTH HAS THE CLOSEST RELATIONSHIP. AND SO, THE TWO OF US, THEN, WORK WITH MENTAL HEALTH TO BRING IN THAT AGENCY. SO, I THINK IT'S HELPING, SIR. 

SUP. ANTONOVICH: AND WITH THE UNIVERSAL FORM, CONSENT FORM BEING DEVELOPED -- 

DR. MITCHELL KATZ: YES. WE'RE CLOSER BUT WE'RE NOT YET THERE. BUT WE'VE HAD GREAT SUPPORT FROM COUNTY COUNSEL AND WE HAVE COME UP WITH COMMON LANGUAGE AND I THINK BY THE NEXT TIME WE PRESENT, IT WILL BE DONE. 

SUP. ANTONOVICH: AND THEN, HOW DO WE COORDINATE WITH THE OTHER AGENCIES THAT WE ARE DEALING WITH? 

DR. MITCHELL KATZ: THAT'S A GOOD SUGGESTION. WE WILL ASK THEM, ONCE COUNTY COUNSEL SIGNS OFF ON THE UNIVERSAL FORM, I THINK IT COULD WORK FOR THE OTHER DEPARTMENTS, AS WELL. WE'LL BRING THEM ALONG. 

SUP. ANTONOVICH: SO, WE'RE LOOKING AT WITHIN A MONTH OR WITH TWO MONTHS? 

DR. MITCHELL KATZ: CERTAINLY BY THE TIME OF THE NEXT UPDATE. I THINK IT COULD BE COULD BE DONE WITHIN 60 DAYS AT THIS POINT. 

SUP. MICHAEL ANTONOVICH:OKAY, THANK YOU. 

DR. MITCHELL KATZ: THANK YOU. 

HILDA SOLIS, CHAIR: ARE THERE QUESTIONS FROM THE BOARD? OKAY, THANK YOU VERY MUCH. WE DO HAVE PUBLIC COMMENT ON THIS ITEM. ARNOLD SACHS AND ERIC PREVEN. 

ERIC PREVEN: YES, IT'S ERIC PREVEN. THANK YOU. THAT IS AN INTERESTING REPORT FROM MESSIAH KATZ. I ENJOYED IT. AND I THINK THAT WE ARE OFF TO A FAIRLY GOOD START. I HAD SOME QUESTIONS, HOWEVER. ONE QUESTION I THOUGHT IT WAS GOOD TO BRING UP, THE QUESTION OF CHILDREN. IT'S NOTICEABLE THAT THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES IS NOT INCLUDED IN THIS GROUP, AND THAT ALWAYS BUMPED ME, BECAUSE I FEEL LIKE THEY ARE PROVIDING SO MUCH IN THE WAY OF COURT-ORDERED HEALTH PRADA AND SUCH. AND WE SHOULD DO A SPECIAL METRIC LOOK AT THE MEDICATION OF THE YOUTH, NOT JUST IN THE FOSTER CARE SYSTEM BUT OVERALL, BECAUSE IT'S AN AREA WHERE THERE'S A LOT OF PUBLIC CONCERN. SOME PEOPLE FEEL THEY DON'T KNOW HOW TO DEAL WITH SOMEONE WHO IS IN CRISIS, SO THEY JUST MEDICATE THEM. AND SOMETIMES IT'S THE RIGHT THING TO DO, SOMETIMES IT'S NOT. I WOULD ALSO THINK A GOOD METRIC WOUDL BE THE INVENTORY SPECIFICALLY OF BEDS, BECAUSE WE HAVE HEARD IN THE PUBLIC THAT THERE ARE BEDS THAT ARE NOT FILLED AND THAT THERE ARE PEOPLE WHO HAVE VOUCHERS BUT CAN'T FIND BEDS AND PLACES TO STAY. SO THIS, OF COURSE, WOULD BE A GREAT NUMBER TO BE TRACKING ON A REGULAR BASIS. I ALSO THOUGHT THAT ONE CONCERN ABOUT ALL THIS METRIC TALK IN GETTING OUR OWN WEBSITE FOR THIS GROUP IS -- AND TRACKING PEOPLE BETWEEN TREATMENTS AND SUCH -- IS DIDN'T WE JUST SPEND A BILLION DOLLARS ON THE ELECTRONIC HEALTHCARE RECORD OR HALF A BILLION OR SOMETHING? I MEAN, ISN'T THAT SORT OF WHAT WE'RE TALKING ABOUT? I JUST FEEL LIKE WE'RE IN A LITTLE BIT OF A REPETITIVE AREA THERE. OF COURSE, THE CELEBRATION IS ABOUT THE URGENT CARE CENTERS. EVERYBODY LOVES AN URGENT CARE CENTER WHEN WE'RE NOT DEALING WITH AN EMERGENCY DEPARTMENT, WHICH CAN BE TRAUMATIC. AND I'M GLAD THAT WE'RE GOING FROM 4 TO 8, BUT HOW MANY MORE CAN WE DO? AND DOESN'T THERE STILL NEED TO BE A PLACE, SUPERVISOR KUEHL? AND I KNOW YOU'RE FOCUSED AT THE MOMENT ON SOMEBODY ELSE, BUT DOESN'T THERE NEED TO BE A PLACE WHERE FOLKS CAN GO, CAN BE DELIVERED IF THEY'RE HAVING SOMETHING IN BETWEEN A TERRIBLE EMERGENCY THAT, I MEAN, LIKE AN URGENT CARE CENTER BUT THEN WHERE YOU CAN ALSO SPEND THE NIGHT, CLEAN UP? AND I KNOW THAT THOSE ARE CALLED SHELTERS AND THAT WE HAVE A GREAT SHORTAGE FOR THAT KIND OF A THING, BUT THE PERMANENT SUPPORTIVE HOUSING PIECE NEEDS TO BE -- AND DR. KATZ EARLY ON STOOD UP AND SAID, "I'M SPENDING SOME OF MY HEALTH BUDGET ON HOUSING BECAUSE IT'S A GOOD DEAL." SO, I WOULD LIKE TO HEAR MORE ABOUT THAT. SO, THANK YOU. 

HILDA SOLIS, CHAIR: NEXT SPEAKER. 

ARNOLD SACHS: YES, THANK YOU. GOOD MORNING. ARNOLD SACHS. AND JUST ON THE WHERE TO START, WELL, WE'LL START WITH, ANYWAY, DR. KATZ MENTIONING HOMELESSNESS AS A CURABLE DISEASE. I WOULD HOPE HE WOULD HAVE A CURE FOR THE LACK OF LEADERSHIP, THAT CANCER THAT WE HAVE IN THIS COUNTY. WORK ON THAT. HE MENTIONED A 50-PERCENT LEVEL OF REDUCTION IN HOMELESSNESS, AND HE MENTIONED 90 PERCENT OF THE 50 PERCENT TO BE HOUSED FOR ONE YEAR. WHAT'S HIS PLAN? WHAT'S YOUR PLAN? WE GOT A PLAN. WE DON'T HAVE ANY MONEY. SO, WHERE IS HIS PLAN THAT INVOLVES MONEY? HE MENTIONED 2,500 SLOTS. SLOTS FOR WHAT? GAMES? WHAT? EMPLOYEES? WHAT? RENTAL UNITS, THE COST OF RENTAL UNITS. THERE'S A STORY IN THE DOWNTOWN NEWS THAT SAYS THERE'S 10,000 UNITS IN THE PIPELINE. AVERAGE RENT, $3,000. WHO CAN AFFORD THEM? THE MENTAL HEALTH URGENT CARE CENTERS.. EXCUSE ME, AND SUPERVISOR KUEHL, I'D LIKE TO MENTION THAT THERE'S JAIL, THERE'S THE EMERGENCY-ROOM MENTAL- HEALTH CENTERS, AND THEN THERE'S THE URGENT-CARE CENTERS. THERE'S DIFFERENTIATE BETWEEN THE THREE. ARE THE PUBLIC, THE FIRST RESPONDERS THOUGHT THAT IF THEY GO TO THE URGENT-CARE CENTERS, THEY CAN JUST DROP THE PATIENTS OFF AND THEY DON'T HAVE TO STAY AROUND LIKE THEY DO AT THE EMERGENCY ROOM FILLING OUT PAPERWORK? IT WAS MENTIONED ABOUT THE L.A.P.D. HAVING A CALL CENTER THAT THEY COULD CALL WHEN DEALING WITH SOMEBODY WHO HAS A PROBLEM. SO, DO THEY PUT THE -- IT'S A FLUID SITUATION. DO THEY SAY, "PLEASE HOLD WHILE I TALK TO THE DOCTOR"? MAYBE YOU COULD HAVE YOUR DOCTOR, MS. SOLIS, AS PART OF THIS CALL CENTER AND HAVE SOME IDEAS. THEY CAN CALL HIM UP AND HE CAN GIVE SOME ADVICE, BECAUSE HE'S ADVISING YOU. YOU APPLAUD THEM. THEY APPLAUD YOU. ONE OF THESE HEARINGS, YOU'LL ALL SING "KUMBAYAH." IT WILL BE WONDERFUL. YOU COULD HAVE A CHOIR WITH SOME MUSIC. IT'S PERFECT. YAY! 

HILDA SOLIS, CHAIR: AS YOU KNOW, THIS IS RECEIVE AND FILE. SO, WITHOUT OBJECTION. OKAY. WE'RE MOVING ON NOW TO ITEM NO. 49-A. SUPERVISOR KUEHL? 

SUP. SHEILA KUEHL: THANK YOU, MADAME CHAIR. I HELD THIS -- THIS IS SUPERVISOR ANTONOVICH'S ITEM ON THE GREEN SHEET ABOUT HIGH-SPEED RAIL -- SIMPLY TO INQUIRE. UNFORTUNATELY, AND I DID ALREADY COMMUNICATE THIS, I CAN'T SUPPORT IT AS WRITTEN. IT SEEMS SORT OF AN ABSOLUTE, BECAUSE AS WE WERE TALKING ABOUT THIS PARTICULAR ALIGNMENT, IT WAS REALLY THE WASH THAT WE WERE MOST CONCERNED ABOUT, OR, AT LEAST, THAT I WAS. BUT IF IT WERE UNDERGROUND, I DID NOT HAVE THE SAME CONCERNS. AND IT SEEMED TO ME THAT THE FIVE-SIGNATURE LETTER WAS KIND OF, FIRST OF ALL, IT DIDN'T SAY THAT THE MAIN CONCERN WAS BECAUSE OF CROSSING THE WASH, AND SECONDLY THAT IT WASN'T AN ABSOLUTE NO IF THERE WAS SOMETHING UNDERGROUNDING. I DON'T THINK THIS ALIGNMENT IS LOOKING VERY POPULAR OVERALL, ANYWAY. BUT I THINK IF WE'RE GOING TO SAY SOMETHING, I'D BE MORE COMFORTABLE, AT LEAST FOR MY PART, THAT WHAT I REALLY AM FOR AND WHAT I'M NOT. 

SUP. ANTONOVICH: WE HAVE SOME PEOPLE TO SPEAK ON THE ITEM. 

HILDA SOLIS, CHAIR: I ALSO JUST WANT TO MENTION THAT IN THE LETTER, I'M ALSO CONCERNED THAT PERHAPS WHAT COULD ALSO BE STATED IS A BROADER CONCERN ABOUT THE IMPACTS IN OTHER SENSITIVE AREAS. FOR EXAMPLE, IN THE COUNTY, TOWARDS THE SAN GABRIEL MOUNTAINS, SOMETHING THAT CAME UP BEFORE AND JUST QUESTIONS THAT WE HAD ABOUT HOW THIS WAS GOING TO LAY OUT IN THE FUTURE. AND A LOT OF FOLKS IN THE AREA I KNOW WERE VERY CONCERNED ABOUT THAT, BECAUSE THE PRESIDENT JUST CALLED FOR THE SAN GABRIEL MOUNTAINS TO BE A PART OF THE HISTORIC MONUMENT PROCESS. SO, THOSE ARE ISSUES THAT I HAVE CONCERNS OF. 

SUP. ANTONOVICH: THERE ARE OTHER CONCERNS, AS WELL, FARTHER NORTH IN L.A. COUNTY, TOO. AND IT IS HAVING A SEVERE IMPACT COUNTY-WIDE IN THESE COMMUNITIES, BREAKING UP COMMUNITIES, GOING THROUGH SENSITIVE AREAS. SO, THE PROBLEM WITH THAT PROPOSITION WHEN IT WAS PASSED, IT BYPASSED ALL LOCAL PLANNING ISSUES, SO THE CITIES AND COUNTIES WHO WERE LOSING AUTHORITY AS TO THESE ROUTES, ALL WE CAN DO IS DO THE JAWBONEING. AND I WOULD SAY IF THIS PROPOSITION WAS ON THE BALLOT TODAY, IT WOULD NOT PASS THE WAY IT WAS WRITTEN. AND WE KNOW OUR GOOD FRIEND SENATOR KOPP, NOW JUDGE KOPP, WAS PUTTING FORTH AN INITIATIVE. I DON'T KNOW THE STATUS OF THAT, WHICH WAS TO HAVE A YES OR NO VOTE ON HIGH-SPEED RAIL AND TRANSFERRING THE MONEY TO THE WATER PROJECTS. I DON'T KNOW IF THAT'S STILL GOING TO BE A VIABLE INITIATIVE FOR THE 2016 ELECTION OR THE 2018. I HAVEN'T HEARD ANYTHING MORE ABOUT THAT. 

SUP. SHEILA KUEHL: WELL, THE CONCERN, THOUGH, JUST WITH THIS PARTICULAR LETTER, I MEAN, I THINK THE LARGER CONCERNS ABOUT HIGH- SPEED RAIL, IN A SENSE, THEY'RE ALL OVER THE MAP BECAUSE THERE ARE COMMUNITIES -- MOST COMMUNITIES SAY NOT, YOU KNOW, DON'T RUN IT THROUGH HERE. BUT THIS PARTICULAR ALIGNMENT, IT GOES THROUGH THE FIFTH INTO THE THIRD. AND, SO, OF COURSE, I'M CONCERNED. I THINK THERE ARE -- IN SIMPLY SAYING NO TO THIS ALIGNMENT, MY ASSESSMENT IS THERE ARE OTHER ALIGNMENTS THAT ACTUALLY IMPACT BOTH OF OUR.. 

SUP. ANTONOVICH: THEY DO. YOU WANT TO HAVE, INCLUDE MORE -- 

SUP. SHEILA KUEHL: ..AREAS, KIND OF BOTH, SOME OF THEM NOT SO GOOD, EITHER. SO, SINGLING THIS OUT MAKES IT SOUND LIKE THE OTHER ONES ARE OKAY. 

SUP. ANTONOVICH: NO. 

SUP. SHEILA KUEHL: AND ALSO SAYING ABSOLUTELY NO TO THIS ONE, WHEN I THINK -- WE HAD A CONVERSATION ABOUT WHETHER IF IT WERE UNDERGROUND IT WOULD BE LESS IMPACT IN GENERAL, NOT RUNNING RIGHT THROUGH THE COMMUNITIES. SO, I THINK MAYBE WE COULD PUT THE LETTER OFF AND HAVE A LITTLE MORE DISCUSSION ABOUT IT, BECAUSE I THINK SINGLING THIS OUT, AS I SAID, MAKES THE OTHERS LOOK OKAY, WHICH THEY MAY NOT BE. AND ALSO, I'M NOT ABSOLUTELY AGAINST TUNNELING, IF THAT'S POSSIBLE. 

SUP. KNABE: I'D SUPPORT TUNNELING, BECAUSE THAT WOULD KILL THE PROJECT. 

SUP. SHEILA KUEHL: [LAUGHTER.] 

SUP. HILDA SOLIS, CHAIR: OKAY.. 

SUP. KNABE: NO, MADAME CHAIR, I HAVE THE SAME CONCERNS, YOU KNOW, ABOUT JUST OUTRIGHT OPPOSING ONE WITHOUT LOOKING AT THE OTHERS. AND I KNOW THERE'S PEOPLE HERE TO TESTIFY, SO WE'LL HEAR THEIR TESTIMONY, BUT I WOULD BE INCLINED TO CONTINUE THE ITEM FOR A FEW WEEKS SO ALL OF OUR OFFICES CAN SORT OF LOOK AT THIS THING AND MAYBE EXPAND THE LETTER THAT MIKE HAS BEFORE US. 

HILDA SOLIS, CHAIR: OKAY. ALL RIGHT. LET'S GO AHEAD AND CALL UP, WE HAVE SEVERAL SPEAKERS: JACQUELINE AYER, DAVE DEPINTO, CILE BORMAN, NINA ROYAL. AND JUST REMEMBER TO STATE YOUR NAME BEFORE YOU SPEAK. THANK YOU. GO AHEAD, MA'AM. 

JACQUELINE AYER: THANK YOU. MY NAME IS JACQUELINE AYER. I'M HERE ON BEHALF OF THE ACTON TOWN COUNCIL. FOR NEARLY 10 YEARS AND AS RECENTLY AS TWO WEEKS AGO, I HAVE BEEN MEETING WITH THE HIGH-SPEED-RAIL ENGINEERS ON BEHALF OF ACTON TOWN COUNCIL AND SHOWN THEM TIME AND AGAIN HOW THEY CAN BUILD THESE ROUTES IN A LESS IMPACTFUL WAY, AND TUNNELING ACTUALLY WON'T KILL THE PROJECT FISCALLY SPEAKING. I'D BEG TO DISAGREE WITH YOU, AND I'D LOVE TO MEET WITH YOU TO DISCUSS IT. BUT AT ANY RATE, WE HAVE SHOWN THEM HOW IT COULD BE CONFIGURED FOR MINIMAL IMPACTS ON THE COMMUNITY OF ACTON. THEY STILL HAVE NOT HEARD. THE ACTON TOWN COUNCIL SUPPORTS SUPERVISOR ANTONOVICH'S MOTION, BECAUSE IT AMPLIFIES THE MESSAGE THAT WE HAVE BEEN TRYING TO SEND FOR NEARLY 10 YEARS. BUT IT DOES NOT GO FAR ENOUGH. EVERYTHING THAT THE MOTION IDENTIFIES AS E.2 IMPACTS ON SHADOW HILLS AND LAKE TERRACE, EXCUSE ME, LAKE VIEW TERRACE IS ENTIRELY APPLICABLE TO ACTON. FROM ACTON'S PERSPECTIVE, THE SELECTION OF ONE ROUTE OVER ANOTHER ACTUALLY IS A PURELY ACADEMIC EXERCISE, BECAUSE EVERY SINGLE ROUTE IMPACTS ACTON WITH SIGNIFICANT ABOVE-GROUND SEGMENTS. IN FACT, ACTON IS THE ONLY COMMUNITY THAT IS NOT PROTECTED BY AT LEAST ONE UNDERGROUND ROUTE. THE S.R.14 ROUTE CROSSES THE 14 FREEWAY FOR MORE THAN A MILE ABOVE GROUND, WITHIN ACTON, AND WITHIN 1,500 FEET OF OUR BRAND-NEW HIGH SCHOOL. E.1 AND E.2 BOTH HAVE MORE THAN 2 MILES OF ABOVE-GROUND SECTIONS IN ACTON, AND THEY DEVASTATE HISTORIC BLUM RANCH. THEY ALSO TRANSITION ABOVE GROUND AT THE BOUNDARY OF THE SAN GABRIEL MOUNTAINS NATIONAL MONUMENT, AND THEY SIGNIFICANTLY IMPACT WITH -- THEY WILL SIGNIFICANTLY IMPACT WITH NOISE, DUST, ALL KINDS OF IMPACTS ON THE ALISO ARRASTRE SPECIAL INTEREST AREA. THE ALISO ARRASTRE SPECIAL INTEREST AREA IS THE FIRST AREA SET OUT FOR SPECIAL PROTECTION BY PRESIDENT OBAMA'S PROCLAMATION. SO, I APPRECIATE THAT YOU SUPERVISORS ARE SENSITIVE TO OTHER COMMUNITIES, AND I JUST URGE YOU TO EXPAND THIS TO INCLUDE OTHER COMMUNITIES WHO ARE EQUALLY IMPACTED. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU. NEXT SPEAKER, PLEASE. 

DAVE DEPINTO: I'M DAVE DEPINTO, PRESIDENT OF THE SHADOW HILLS PROPERTY OWNERS ASSOCIATION. THANK YOU VERY MUCH. WE APPRECIATE AND SUPPORT THE MOTION TO REMOVE E.2, BUT WE ALSO SUPPORT EXTENDING IT TO DEAL WITH OTHER ABOVE- GROUND AREAS, WHETHER IT'S ACTON, AGUA DULCE, THE SAN GABRIEL VALLEY, THE SOUTHEAST CITIES. WE'VE LEARNED A HARD LESSON THROUGH SANTA CLARITA AND THE MANY OTHER COMMUNITIES THAT HAVE ALREADY BEEN SPARED THIS IMPACT THAT THE ABOVE-GROUND STRUCTURES ARE JUST INTOLERABLE NEAR RESIDENTIAL COMMUNITIES AND SENSITIVE ENVIRONMENTAL AREAS. WE WANT TO MAKE CLEAR THAT A MOTION SUCH AS THIS DOES NOT TIE THE HANDS OF HIGH-SPEED RAIL. THEY STILL HAVE TWO TUNNELED ALTERNATIVES IN THEIR E.I.R. STUDIES, AND THEY HAVE PLENTY OF TIME. THEY SAY THEY'RE NOT GOING TO BUILD UNTIL 2029. THEY CAN IDENTIFY NEW ALTERNATIVES AND STUDY THEM. THEY WILL TELL YOU THEY DON'T, BUT THEY DO. WE THINK THAT THE MOTION, EVEN AN EXPANDED MOTION, IS VERY CONSISTENT WITH THE HIGH-SPEED RAIL'S DECISIONS IN OTHER COMMUNITIES, PARTICULARLY SUPERVISOR KUEHL'S DISTRICT AND THAT THERE'S UNFINISHED BUSINESS AND THAT THIS IS AN IMPORTANT PRECEDENT TO HELP SET FOR THROUGHOUT THE ENTIRE REGION AS THESE PLANS BECOME MORE AND MORE CLEAR. WE CERTAINLY WANTED TO BRING THIS TO YOUR ATTENTION, BECAUSE THE BIG T WASH AND THE MITIGATION AREA IS UNDER YOUR JURISDICTION THERE TO PROTECT THE SANTA ANA SUCKER, THE WATER SUPPLY THAT GOES THROUGH THERE, THE WILDLIFE, ETC. SO, WE'RE ALL TOGETHER. THE COMMUNITIES HAVE WORKED TOGETHER. EVERY ELECTED OFFICIAL ON THE NORTHEAST SAN FERNANDO VALLEY SUPPORTS THESE POSITIONS. WE THINK IT WOULD BE VERY IMPORTANT IF OUR ELECTED OFFICIALS CAN COALESCE AND HAVE A UNITED FRONT ON THIS COMMON GROUND. THAT'S BEEN THE THEME OF OUR EFFORT, IS FINDING COMMON GROUND THAT EVERYBODY CAN RALLY AROUND, WHETHER IT'S THE SAN GABRIEL VALLEY, THE SOUTHEAST CITIES, ETC. WE'RE ALL, AS WE SEE THESE MAPS AND THESE LINES, WE ALL FACE THESE REALITIES. SO, YOU'RE GOING TO HEAR FROM SOME OF OUR FRIENDS AND SOME OF THE NIGHTMARES THEY'RE DEALING WITH. WE HAD FOLKS HAVING THEIR PROPERTY APPRAISED THIS MORNING WHO ARE HERE TO TALK TO YOU TODAY. IT'S A TERRIBLE BURDEN FOR US. WE ENCOURAGE AND HOPE THE BOARD TAKES ACTION. THANK YOU. 

SUP. ANTONOVICH: THANK YOU, DAVE. 

HILDA SOLIS, CHAIR: THANK YOU. NEXT SPEAKER. 

CILE BORMAN: YES, I'M CILE BORMAN FROM THE LAKE VIEW TERRACE IMPROVEMENT ASSOCIATION. LIKE PACOIMA, SAN FERNANDO, AND SANTA CLARITA, LAKE VIEW TERRACE IS A WORKING-CLASS, MULTIETHNIC, MULTICULTURAL COMMUNITY STRUGGLING TO RAISE OUR CHILDREN IN A HEALTHY ENVIRONMENT. WHILE OVER TWO DECADES AGO OUR COMMUNITY, SITUATED ALONG THE 210 FREEWAY, WAS ASSURED THAT THERE WERE FUNDS AVAILABLE FOR A SOUND WALL WHICH WE NEVER RECEIVED, NOW, TO ADD INSULT TO INJURY, WE'RE BEING THREATENED WITH THE ADDED NOISE OF A TRAINS GOING 220 MILES AN HOUR THROUGH AND DIVIDING OUR LAKE VIEW TERRACE COMMUNITY. PLEASE RELEASE LAKE VIEW TERRACE AND ANY OTHER COMMUNITY FROM THE THREAT OF ANY ABOVE-GROUND HIGH-SPEED TRAIN ROUTE LIKE E.2 ROARING THROUGH THE BIG TUJUNGA WASH AND DIVIDING THEIR COMMUNITY. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU, MA'AM. NEXT SPEAKER? 

NINA ROYAL: GOOD MORNING. I'M NINA ROYAL, AND I'M REPRESENTATIVE OF SUNLAND-TUJUNGA, AND I'M ON THE LAND-USE COMMITTEE FOR THE SUNLAND-TUJUNGA NEIGHBORHOOD COUNCIL. AND WE SUPPORT MR. ANTONOVICH'S PROPOSAL. THE EQUITY OF THE NORTHEAST SAN FERNANDO VALLEY, LAKEVIEW TERRACE, SHADOW HILLS, AND SUNLAND-TUJUNGA, WHICH IS THE GATEWAY TO THE ANGELES FOREST, AND THE ABOVE-GROUND 220 MILE- PER-HOUR TRAINS ARE JUST WRONG. I REALLY BELIEVE THAT YOU SHOULD NOT COME TO A MEETING AND DISAGREE WITHOUT HAVING A SOLUTION. I PERSONALLY BELIEVE, AND SO DO MOST OF THE MEMBERS OF MY COMMUNITY, WHICH THE HIGH-SPEED RAIL HAS PRETTY MUCH IGNORED, EVEN THOUGH THE FACT OF THE BIG TUJUNGA WASH IS IN SUNLAND- TUJUNGA, THE HIGH SPEED RAIL SHOULD NOT COME SOUTH OF THE PALMDALE. WE HAVE BUSSES. WE HAVE METROLINK. WE HAVE EVERYTHING ELSE TO TAKE PEOPLE OUT TO PALMDALE AND NOT HAVE TO HAVE THIS DISCUSSION OF WHETHER OR NOT IT SHOULD BE COMING THROUGH THE ANGELES FOREST OR DOWN THE S.R.14. THERE'S BEEN NO OUTREACH IN THE SUNLAND-TUJUNGA AREA IN OUR AREA OF THE VALLEY IN OVER A YEAR. THIS IS FLAT-OUT WRONG, TOO. THEY PROMISED US THAT THEY WOULD COME BACK WITH A -- EXCUSE ME. I HAVE A HARD TIME TALKING. LIKE I SAID, I HAVE RESPIRATORY PROBLEMS, AND I'VE LIVED IN THAT AREA FOR 30 YEARS. AND NOW YOU GUYS WANT TO RUIN IT. YOU'RE GOING TO MAKE IT VERY HARD FOR PEOPLE LIKE ME, WHICH IS A LARGE PERCENTAGE OF THIS AREA THAT ARE THERE BECAUSE OF RESPIRATORY PROBLEMS. AS YOU WELL KNOW, OUR AREA WAS VERY FAMOUS FOR SUNAIR AND ALL THE OTHER HOMES FOR PEOPLE THAT DO HAVE RESPIRATORY PROBLEMS. AND NOW, WHAT HAPPENED TO THE EQUITY FOR THE HEALTH AND ENVIRONMENT OF PEOPLE LIKE ME? SORRY. GOT TO GO. 

HILDA SOLIS, CHAIR: THANK YOU. WE HAVE SEVERAL OTHER SPEAKERS: BILL EICK, ARNOLD SACHS, KATHLEEN TRINITY, SUSAN STEDMAN, DALE STEDMAN, TINA PETROSIAN, TRACEY ADAMS. GO AHEAD, SIR. STATE YOUR NAME, PLEASE. 

BILL EICK: YES. MY NAME IS BILL EICK, E.I.C.K. I'M WITH THE SHADOW HILLS PROPERTY OWNERS ASSOCIATION. I LIVE, HOWEVER, IN THE THIRD SUPERVISORIAL DISTRICT, THAT PORTION OF SHADOW HILLS THAT'S IN THAT DISTRICT. SUPERVISOR KUEHL'S SUGGESTION THAT THE TRAIN GO UNDERGROUND UNDER THE WASH, AS MICHELLE BAINE SAID, IF YOU TOUCH IT, YOU OWN IT. AND IT PROVIDES BASICALLY THE WATER SUPPLY FOR ENDANGERED PLANTS AND ANIMALS. AND TECHNICALLY, FROM THE LAWS OF PHYSICS, IT CAN'T WORK, BECAUSE IN ORDER TO COME OUT IN BURBANK, IT HAS TO BE A CERTAIN HEIGHT, AND IF YOU PUT IT UNDERGROUND UNDER THE TUJUNGA WASH, IT WILL NEVER MAKE THAT HEIGHT, GIVEN THE SPEEDS REQUIRED. SO, BUT IF YOU WANT TO SAY IT'S UNDERGROUND, THAT'S FINE. IT'S JUST TECHNICALLY NOT POSSIBLE. THE TUJUNGA WASH IS THE LOS ANGELES RIVER BEFORE CEMENT. THE CITY IS SPENDING GAZILLIONS OF DOLLARS TRYING TO FIX THE L.A. RIVER AND EXPAND IT. THIS IS THE LOS ANGELES RIVER BEFORE CEMENT. DON'T RUIN IT BY PUTTING IN PILLARS THAT ARE, YOU KNOW, HAVE TO REACH BEDROCK -- AND NOBODY KNOWS WHERE THAT IS JUST YET -- IN THE MIDDLE OF AN AREA WHICH IS JUST EAST OF THE LOS ANGELES COUNTY MITIGATION BANK. WHAT'S GOING TO HAPPEN IS YOUR MITIGATION BANK, THE ONE THAT THE DEPARTMENT OF PUBLIC WORKS USES TO DO OTHER THINGS, WILL ACTUALLY END UP BEING DESTROYED. YOU, BEING THE COUNTY, ME, BEING COUNTY TAXPAYER, ARE GOING TO HAVE TO PAY ADDITIONAL AMOUNTS OF MONEY FOR AN ADDITIONAL MITIGATION BANK, BECAUSE YOU WILL RUIN THE ONE THAT YOU HAVE, BECAUSE MITIGATION BANKS, YOU DON'T GET THE CREDIT FOR OWNING IT. YOU GET THE CREDIT FOR MAINTAINING IT. AND THIS WILL, IN FACT, BE DESTROYING IT. I HAVE OTHER THINGS, BUT I ONLY HAVE NINE SECONDS, SO I'LL STOP. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU MUCH. NEXT SPEAKER? 

SUSAN STEDMAN: SUSAN STEDMAN, SHADOW HILLS. I OPPOSE THE REFINED E.2 ALIGNMENT FOR C.H.S.R.'S PALMDALE-TO-BURBANK H.S.R. PROJECT SEGMENT AND ANY OTHER VARIATION OF THIS ALIGNMENT THAT WOULD CROSS THE BIG TUJUNGA WASH AT OR ABOVE GRADE. THE REFINED E.2 CAUSES MORE DISPLACEMENT AND CONDEMNATION OF RESIDENTIAL PROPERTIES THAN ALL OF THE ALTERNATIVES BEING REVIEWED AND WOULD DIVIDE LAKE VIEW TERRACE. THIS ROUTE ALSO CROSSES THE LARGEST AMOUNT OF EARTHQUAKE FAULTS, AND IT TUNNELS IN CLOSE PROXIMITY TO MORE OIL AND GAS WELLS IN THE S.R.14 AND E.1. AS WITH THE OTHER ALTERNATIVES, IT IS INCONSISTENT WITH EXISTING LAND USES IN UNINCORPORATED L.A. COUNTY, L.A., AND BURBANK. FURTHERMORE, E.2 IS THE ONLY ALTERNATIVE THAT WOULD HAVE ADDITIONAL INCONSISTENT LAND-USE IMPACTS IN AND NEAR THE BIG TUJUNGA WASH. THE MOST TROUBLING PART OF THE REFINED E.2 ALIGNMENT IS THE UNMITIGABLE IMPACTS TO THE FEDERALLY ENDANGERED AND PROTECTED SANTA ANA SUCKER FISH'S WETLAND HABITAT. CONSTRUCTING AN ABOVE-GROUND VIADUCT THROUGH THE BIG TUJUNGA WASH WOULD THREATEN THE PERENNIAL HAINES CANYON CREEK, A VITAL SOURCE OF DRINKING WATER FOR THE CITY OF L.A. OTHER ENDANGERED SPECIES FOUND IN THE BIG TUJUNGA WASH WOULD MOST ASSUREDLY BE DISTURBED AND WIPED OUT WITH THE CONSTRUCTION OF THE E.2 ALTERNATIVE. C.H.S.R.A. CHAIRMAN DAN RICHARD STATED THAT THIS LAND WAS ALREADY DISTURBED, SINCE THE E.2 ALTERNATIVE IS AT THE LOCATION BETWEEN TWO MAJOR HIGH- VOLTAGE TRANSMISSION LINES THROUGH THE BIG T WASH. THE CHAIRMAN WAS CORRECT THAT HIGH-VOLTAGE TRANSMISSION LINES DO TRAVERSE THIS AREA, BUT THE POWER LINES HAVE ONLY ONE TOWER EACH IN THE WASH, AND THE SPAN BETWEEN THE CLOSEST TOWERS ARE ALMOST 1,900 FEET APART AND NOT LOCATED ON WETLANDS. THEREFORE, THE POWER LINES DO NOT DISTURB THE CRITICAL HABITAT. C.H.S.R.A. WOULD NEED TO BUILD A BRIDGE IN THIS AREA SPANNING ALMOST 1,900 FEET BETWEEN PIER SUPPORTS TO COMPARE ITSELF TO THESE POWER LINES. THIS WOULD MAKE IT THE THIRD LARGEST SPAN OF BRIDGES IN CALIFORNIA AFTER THE GOLDEN GATE AND OAKLAND BAY BRIDGES. I ASK THAT TO IMMEDIATELY REMOVE THE E.2 -- I KNOW I'VE RUN OUT OF TIME -- AND ANY OTHER ABOVE-GROUND IMPACTS IN L.A. COUNTY, AND I ASK THAT YOU SIGN THE LETTER TO SUPPORT THE REMOVAL OF THE E.2 AND OTHER ABOVE-GROUND IMPACTS. THANK YOU. 

HILDA SOLIS, CHAIR: THANK YOU. NEXT SPEAKER? 

DALE STEDMAN: DALE STEDMAN, SHADOW HILLS. I OBJECT TO THE E.2 AND OTHER ABOVE-GROUND SEGMENTS. IT WOULD CAUSE TREMENDOUS IMPACTS NOT ONLY TO ONE OF THE FEW REMAINING EQUESTRIAN COMMUNITIES IN THE CITY OF LOS ANGELES, WHICH MUST BE PRESERVED AND PROTECTED, BUT ALSO TO ONE OF THE SAN FERNANDO VALLEY'S LARGEST AFRICAN-AMERICAN NEIGHBORHOODS. THIS E.2 ROUTE WOULD CAUSE UNMITIGATABLE ENVIRONMENTAL IMPACTS TO ENDANGERED-SPECIES HABITAT AND POTENTIALLY LEAD TO AN EXTINCTION OF THE FEDERALLY ENDANGERED AND PROTECTED SANTA ANA SUCKER FISH WITHIN THE BIG TUJUNGA WASH. CONSTRUCTING AN ABOVE-GROUND E.2 VIADUCT FOR THE BIG TUJUNGA WASH WOULD HAVE A HIGH PROBABILITY TO POLLUTE AND CONTAMINATE A MAJOR SOURCE OF LOS ANGELES CITY'S DRINKING WATER. ALLOWING E.2 AND OTHER ABOVE-GROUND 220-MILE-PER-HOUR TRAINS NEAR RESIDENTIAL AND SENSITIVE AREAS TO EXIST IN C.H.S.R.A.'S E.I.R. IS A ENVIRONMENTAL DISASTER WAITING TO HAPPEN. THE REFINED E.2 ALIGNMENT CUTS THROUGH AND SPLITS UP ONE OF THE LAST, LARGEST, MOST ACCESSIBLE, UNIQUE, AND DIVERSE, RECREATIONAL WONDERLANDS IN LOS ANGELES CITY. THIS BEAUTIFUL OPEN-SPACE AREA EXTENDS FROM THE HANSEN DAM RECREATIONAL AREA THROUGH THE BIG TUJUNGA WASH AND UP INTO THE BIG TUJUNGA CANYON. THIS LONG-UNINTERRUPTED RECREATIONAL PARADISE IS SAN FERNANDO VALLEY'S GATEWAY TO THE ANGELES NATIONAL FOREST. IT IS OFTEN FREQUENTED AND VERY NEAR TO THE VALLEY'S LARGE LOW-INCOME URBAN COMMUNITIES THAT ARE IN DIRE NEED OF OPEN SPACES THROUGH SAN FERNANDO VALLEY. C.H.S.R.'S APPROVAL FOR THE REFINED E.2 ALIGNMENT TO BE CARRIED THROUGH THE REMAINDER OF THE E.I.R. IS RIDICULOUSLY SHORT-SIGHTED WHEN EVERYONE IS AWARE THAT THE MILE-LONG E.2 VIADUCT OVER THE BIG TUJUNGA WASH WOULD BE AN OBSTACLE AND CURTAIL ACCESS TO A VARIETY OF RECREATIONAL ACTIVITIES. THE REFINED E.2 ALIGNMENT IS NOT COMPATIBLE FOR THIS AREA, AND IT HAS A BROAD NEGATIVE IMPACT ON RECREATIONAL ACTIVITIES FOR ALL SOCIOECONOMIC GROUPS. 

SUP. HILDA SOLIS, CHAIR: THANK YOU, SIR. 

DALE STEDMAN: AND WE SUPPORT OUR FRIENDS IN ACTON AND AQUA DULCE ALSO. AND PLEASE SIGN THE FIVE-PAGE LETTER, EVERYBODY. WE BEG YOU. 

SUP. HILDA SOLIS, CHAIR: GO AHEAD. 

KATHLEEN TRINITY: GOOD MORNING, CHAIR SOLIS AND SUPERVISORS. MY NAME IS KATHLEEN TRINITY FROM ACTON. I BELIEVE YOU MUST INCLUDE THE COMMUNITY OF ACTON IN YOUR LETTER TO THE CALIFORNIA HIGH- SPEED RAIL. LIKE THE FOOTHILL COMMUNITIES, WE, TOO, ARE A RURAL AND SEMI- RURAL MOUNTAIN COMMUNITY AND AN EQUESTRIAN COMMUNITY, AS WELL. THERE ARE TWO PROPOSED ROUTES THAT CAN SEVERELY DAMAGE AND DEGRADE ACTON: THE REFINED E.1/E.2 AND THE S.R.14. THE REFINED E.1/E.2 WILL NOT ONLY TAKE OUT HOMES BUT SEVERELY REDUCE THE QUALITY OF LIFE FOR ANOTHER MANY, MANY HOMES, WHICH WILL BE PLAGUED BY THE NOISE AND BLIGHTED FOREVER. EQUESTRIANS KNOW THAT EVENTUALLY MOST HORSES CAN ACCOMMODATE TO REPETITIVE NOISE, BUT TAKING A HORSE OUT ON THE TRAIL IS AN ENTIRELY DIFFERENT MATTER. FOR THAT, HORSES WILL NEED TO BE CAREFULLY TRAINED FOR MONTHS, EVEN YEARS, AND ONLY A MINORITY OF HORSES CAN BE ABLE TO BE TRAINED TO STAY CALM. THE JOURNAL OF TRAUMA MANAGEMENT, 2009, FEBRUARY, REPORTED THAT THE NUMBER OF CONCUSSIONS, BRAIN INJURIES, BROKEN BONES, TORN TENDONS, AND SPINAL INJURIES SUSTAINED IN HORSEBACK RIDING EXCEED THOSE OF MOTORCYCLE ACCIDENTS. IMAGINE TRYING TO TRAIN YOUR HORSE NEAR A HIGH-SPEED RAIL TUNNEL WHERE A SONIC BOOM EFFECT WILL OCCUR EVERY 5 TO 10 MINUTES. EVEN THE VISUAL STIMULUS OF A FAST-MOVING TRAIN WILL BE ABLE TO CAUSE THE HORSE TO BOLT AND THROW THE RIDER. THE SAME SITUATION IS TRUE FOR THE ACTON COMMUNITY AT RED ROVER MINE ROAD. HERE, HOMES WILL BE TAKEN OUT AND AS AS MANY OF 45-50 HOMES IN ADDITION COULD BE DEGRADED, BECAUSE THE ROUTE WILL BE BUILT ON A 30-FOOT CEMENT VIADUCT ONE MILE LONG AT THE MOUTH OF THE CANYON. THE SOUND WILL NEVER BE ADEQUATELY MITIGATED BECAUSE OF THE NATURE OF THE CANYON, WHICH RISES SOUTH TO NORTH, CREATING A VAST ECHO FOR ALL THE RESIDENTS. THERE ARE OVER 80 HORSES IN THIS AREA, AND MANY RESIDENTS RIDE TRAILS. THE S.R.-14 WILL BE DEVASTATING TO THE 112 HOMES HERE. IT WILL ALSO AFFECT THE ENTIRE COMMUNITY, BECAUSE SOME BOARD THEIR HORSES HERE. OTHERS GIVE RIDING AND TRAINING LESSONS. WE ASK THAT YOU INCLUDE ACTON IN YOUR LETTER TO THE HIGH-SPEED RAIL AUTHORITY. 

HILDA SOLIS, CHAIR: THANK YOU, MA'AM. THANK YOU. NEXT SPEAKER? 

TINA PETROSSIAN: HELLO. MY NAME IS TINA PETROSIAN. I'M A RESIDENT OF LAKE VIEW TERRACE. I'VE LIVED IN THE COMMUNITY FOR OVER 15 YEARS, AND 2 1/2 YEARS AGO, I BOUGHT MY FIRST HOME. THE REVISED E.2 ROUTE ABOVE-AN- AT-GRADE ROUTE IS AFFECTING THE QUALITY OF LIFE FOR MYSELF AND MY NEIGHBORS. THE ROUTE THREATENS MY HOME WITH EMINENT DOMAIN. I WAKE UP EVERY MORNING WITH THE THOUGHT THAT I MIGHT LOSE MY HOME. THEY HAVE INVADED OUR PRIVACY WITH PERMISSION-TO-ENTER LETTERS AND ENVIRONMENTAL STUDIES FOR SOUND AND VIBRATION TESTS. THEY ARE BLOCKING OUR STREETS, INTERRUPTING OUR RIGHT OF WAY TO COMPLETE THESE TESTS. THEY HAVE HELICOPTERS FLYING OVER OUR HOMES ON A DAILY BASIS FOR MAPPING AND AERIAL TESTS, DISTURBING OUR QUIET NEIGHBORHOODS AND INTERRUPTING NAP TIME FOR MY 1-1/2-YEAR-OLD. WE ARE SCARED, AND WE FACE THIS TYPE OF UNCERTAINTY FOR YEARS. THEY ARE THREATENING OUR PROPERTY VALUES. SO, TODAY, AS I SIT IN FRONT OF YOU, I HAD AN APPRAISAL DONE ON MY HOME, WHICH I HAD TO PAY AN ATTORNEY, COSTING ME EXTRA MONEY, IN HOPES TO PROTECT MY PROPERTY VALUE AND HELP THE COMMUNITY WHEN THE TIME DOES COME. WHO WANTS TO LIVE NEXT TO A TRAIN GOING 200-PLUS MILES AN HOUR? I WON'T BE THERE, BUT THE PEOPLE THAT WILL STAY ARE GOING TO HAVE TO SACRIFICE THEIR DAILY LIVING. E.2 IS ALSO AFFECTING MY EXTENDED FAMILY, WHICH LIVES THREE MILES FROM ME IN SHADOW HILLS. MY PARENTS ARE IN A CONSTANT WORRY THAT I MAY HAVE TO MOVE FURTHER AWAY WITH MY KIDS IN ORDER TO LIVE AN AFFORDABLE LIFE. GRANDPARENTING WON'T BE THAT EASY. AS PROPERTY VALUES IN LOS ANGELES COUNTY RISE, I MAY NOT BE ABLE TO PURCHASE A NEW HOME IN LOS ANGELES. MY FAMILY, NEIGHBORS, COMMUNITY, AND I ARE CONSTANTLY BEING SHADOWED BY THE THREAT OF LOSING OUR COMMUNITY AND OUR HOMES. WE ARE SPENDING LOTS OF TIME AND FOCUSING ON WAYS TO REMOVE THIS ABOVE-AN-AT-GRADE ROUTE ALIGNMENT FOR IT TO GO AWAY INSTEAD OF BETTERING OUR COMMUNITIES FOR A BETTER WAY OF LIFE. 

HILDA SOLIS, CHAIR: THANK YOU, MA'AM. THANK YOU VERY MUCH. NEXT SPEAKER? 

ARNOLD SACHS: YES, THANK YOU. GOOD MORNING. ARNOLD SACHS. OTHER THAN THE ALIGNMENT, I'M MORE CONCERNED ACTUALLY WITH THIS HIGH-SPEED-RAIL FUNDING. SO INSTEAD OF SENDING A LETTER ABOUT THE ALIGNMENT, WHY DON'T YOU SEND A LETTER REGARDING YOUR THOUGHTS ON THE HIGH-SPEED-RAIL PROJECT IN AND OF ITSELF, BECAUSE YOU'LL HAVE THESE HEARINGS FOR THE NORTH COUNTY, AND WHATEVER THEY DECIDE TO DO, THEN YOU'RE GOING TO NEED TO HAVE THE SOUTH COUNTY. SO THIS WILL BE REPLAYED ALL OVER AGAIN, AND IT WILL BE "NOT IN MY BACKYARD." CHINA, JAPAN, SPAIN AND FRANCE ALL HAVE HIGH-SPEED RAIL LINES, PROBABLY OVER 1,000 MILES OF HIGH-SPEED RAIL. SOMEHOW THEY'VE MANAGED TO DO IT, AND SOMEHOW IT'S MANAGED TO BE SUCCESSFUL. SOMEHOW THEY MANAGED TO MAKE THE BUDGET. THE BIGGEST PART OF THIS BOONDOGGLE, OTHER THAN SOME PEOPLE TALKING ABOUT THE SANTA ANA SUCKER, IS THE CALIFORNIA POPULATION SUCKER THAT IS BEING TOLD THAT THIS HIGH-SPEED-RAIL PROJECT IS GOING TO BE X AMOUNT OF DOLLARS, WHEN EVERYBODY KNOWS THAT IT WILL BE X-SQUARED AMOUNT OF DOLLARS, WHICH IS A LITTLE BIT DIFFERENT. AND FOR THIS BOARD, THAT'S GOING TO BE CONSIDERING A MEASURE SALES TAX FOR THE LOCAL AREA THAT'S SUPPOSEDLY GOING TO RAISE $120 BILLION, WHEN THE LAST SALES TAX IS AT 50 PERCENT OF THE LEVEL. FOR YOU TO BE MAKING ANY KIND OF FINANCIAL DECISIONS IS RIDICULOUS. SO, IF YOU'RE AGAINST THE ALIGNMENT BUT FOR THE PROJECT, OR YOU'RE AGAINST THE PROJECT, TALK ABOUT BEING AGAINST THE PROJECT, BECAUSE YOU'RE GOING TO HAVE THESE SAME CONVERSATIONS OVER AND OVER AGAIN, AND ALL YOU'RE GETTING FROM THE HIGH-SPEED RAIL IS WE'RE GOING TO HAVE SOMETHING THAT'S NOT GOING TO BE OPERATIONAL. KEEP THAT IN MIND WHEN YOU'RE TALKING ABOUT -- 

SUP. HILDA SOLIS, CHAIR: OKAY MEMBERS, THIS ITEM IS BEFORE US. 

LORI GLASGOW, EXEC. OFCR.: MADAME CHAIR, THERE IS AN AMENDMENT BY SUPERVISOR ANTONOVICH TO CONTINUE THIS ITEM FOR THREE WEEKS IN ORDER TO INCLUDE MORE IMPACTED AREAS. 

SUP. HILDA SOLIS, CHAIR: OKAY, THAT MOTION HAS BEEN MOVED BY ANTONOVICH, SECONDED BY KNABE, WITHOUT OBJECTION. SUCH WILL BE THE ORDER. VERY GOOD. MOTION PASSES. ALL RIGHT. I BELIEVE THAT TAKES US TO SPECIAL ITEMS AND ADJOURNMENTS, AND WE START WITH SUPERVISOR KUEHL. 

SUP. SHEILA KUEHL: THANK YOU, MADAME CHAIR. I VOTE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF HARRY FALK, A T.V. AND FILM DIRECTOR, WHO DIED APRIL 29TH IN SANTA MONICA. HIS FIRST DIRECTING OPPORTUNITY WAS ON "THE PATTY DUKE SHOW," WHERE HE MET HIS FUTURE WIFE OF FIVE YEARS, PATTY DUKE. HIS OTHER T.V. SERIES CREDITS INCLUDED "THE DORIS DAY SHOW," "GET SMART," "FLYING NUN," "MAGNUM P.I.," "THE ROCKFORD FILES," AND "THE STREETS OF SAN FRANCISCO." HE ALSO DIRECTED OVER 200 TELEVISION AND MINISERIES AND WAS NOMINATED FOR EMMYS AND A D.G.A. AWARD AND RECEIVED AN N.A.A.C.P. AWARD FOR HIS MOVIE FOR TELEVISION "THE SOPHISTICATED GENTS." HE'S SURVIVED BY HIS WIFE OF 27 YEARS, CANDACE FALK AND HIS DAUGHTER, SENA FALK. AND I ASK THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF MELL LAZARUS, WHO DIED ON MAY 31ST. HE DROPPED OUT OF HIGH SCHOOL AT THE AGE OF 16 AFTER SELLING HIS FIRST COMIC STRIP, AND OVER THE COURSE OF HIS LIFE, HE WROTE AND DREW MORE THAN 33,000 COMIC STRIPS. HE'S BEST KNOWN FOR HIS STRIP "MISS PEACH," WHICH RAN IN NEWSPAPERS FROM 1957 TO 2002 ABOUT "A YOUNG SCHOOLMARM AND A ROOM FULL OF ROTTEN KIDS," AS HE PUT IT. AND IN 1970, HE STARTED "MOMMA," WHICH WAS FOCUSED ON A WIDOW TRYING TO RETAIN CONTROL OF HER CHILDREN. MR. LAZARUS, A PAST PRESIDENT OF THE NATIONAL CARTOONISTS SOCIETY, WAS INSTRUMENTAL IN SECURING OWNERSHIP RIGHTS FOR COMIC-STRIP CREATORS. HE WON THE SOCIETY'S REUBEN AWARD FOR CARTOONIST OF THE YEAR FOR "MISS PEACH" IN 1981 AND ITS MEDAL OF HONOR THIS YEAR. HE'S SURVIVED BY HIS WIFE, SALLY MITCHELL, AND THREE DAUGHTERS FROM HIS FIRST MARRIAGE, MARJORIE WHITE, SUESAN PAWLITSKI, AND CATHIE LAZARUS. AND FINALLY, I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF ROSE ENGEL, WHO DIED ON MAY 29TH. SHE WORKED FOR THE LOS ANGELES UNIFIED SCHOOL DISTRICT AS A CONSULTANT IN ALL OF THE DISTRICT'S SPECIAL-NEEDS SCHOOLS. SHE WROTE SEVERAL BOOKS, INCLUDING "LANGUAGE MOTIVATING EXPERIENCES FOR YOUNG CHILDREN," WHICH WAS WIDELY USED BY HER PEERS IN SPECIAL EDUCATION. IN 1969, SHE BECAME THE PRINCIPAL OF THE SALVIN SCHOOL, WHERE SHE INITIATED REVERSE MAINSTREAMING, WHERE FULLY ABLED KIDS WERE PLACED IN THE CLASSROOM WITH CHILDREN WITH DISABILITIES. IN HER HONOR, THE SCHOOL CREATED A PARK THAT BEARS HER NAME. AND SHE ALSO LED THE LOKRANTZ SPECIAL EDUCATION SCHOOL. LATER IN HER LIFE, SHE DEVOTED HERSELF TO PHILANTHROPIC ENDEAVORS, ENDOWING A SCHOLARSHIP IN SPECIAL ED AT C.S.U.N. AND SUPPORTING MANY PROGRAMS AT ADAT ARI EL DAY SCHOOL. AT AGE 90, 9 YEARS BEFORE HER DEATH, SHE BECAME A BAT MITZVAH, THE CELEBRATION NOT OPEN TO GIRLS WHEN SHE WAS YOUNG. THANK YOU, MADAME CHAIR. 

HILDA SOLIS, CHAIR: WITHOUT OBJECTION. SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU, MADAME CHAIR, MEMBERS. FIRST I MOVE TODAY THAT WE ADJOURN IN MEMORY OF DONALD AVERY KELLER, WHO PASSED AWAY ON MAY 22ND AFTER A COURAGEOUS TWO-YEAR BATTLE WITH PANCREATIC CANCER. DONALD WAS THE SECOND OF SIX SONS TO DON AND BETTY KELLER. HE ATTENDED MILLIKAN HIGH SCHOOL, VERY INVOLVED IN SPORTS THERE. HE ATTENDED LONG BEACH CITY COLLEGE AS WELL AS CAL STATE UNIVERSITY, LONG BEACH. HE WAS A -- CAREER WAS DEFINED BY HIS DEDICATED WORK AS A PRINCIPAL OF STANFORD MIDDLE SCHOOL AND CO-PRINCIPAL OF MILLIKAN HIGH SCHOOL, BOTH INSTITUTIONS WHICH HE ATTENDED AND LOVED AS A YOUNG MAN. HE WAS A DEVOTED SON, HUSBAND, FATHER, AND GRANDFATHER. HE IS SURVIVED BY HIS MOTHER, BETTY, HIS WIFE, GAIL, TWO CHILDREN, TWO GRANDCHILDREN, FIVE BROTHERS, AND MANY NIECES AND NEPHEWS. HE WILL BE MISSED BY ALL WHO KNEW HIM. ALSO THAT WE ADJOURN IN MEMORY OF DONNA MAY JENSEN, WHO PASSED AWAY AT THE AGE OF 76 ON MAY 23RD. DONNA WAS BORN IN HONOLULU, WAS A RETIRED CIVIL SERVICE WORKER AND A PROFESSIONAL ENTERTAINER. SHE IS SURVIVED BY HER FOUR SONS, FOUR DAUGHTERS, ONE BROTHER, THREE SISTERS, 29 GRANDCHILDREN, AND 18 GREAT- GRANDCHILDREN. SHE WILL BE MISSED BY HER FAMILY AND FRIENDS. ALSO THAT WE ADJOURN IN MEMORY OF JOSEPH "JOE" KENNEDY, LONGTIME UNINCORPORATED WHITTIER RESIDENT AND A RETIRED COUNTY EMPLOYEE, PASSED AWAY AT THE AGE OF 93 ON MAY 28TH. HE WAS A VERY THOUGHTFUL AND CARING PERSON, VERY HELPFUL AND DEVOTED TO IMPROVING HIS COMMUNITY AND TO PUBLIC SERVICE, SERVING AS A MEMBER OF THE UNINCORPORATED WHITTIER COORDINATING COUNCIL. HE WAS RAISED BACK IN MICHIGAN, ATTENDED MICHIGAN STATE, AND SERVED FOR TWO YEARS IN THE PACIFIC WITH THE NAVY DURING WORLD WAR II. AFTER THE WAR, JOE RELOCATED TO CALIFORNIA AND BEGAN WORKING FOR LOS ANGELES COUNTY REGIONAL PLANNING DEPARTMENT AS A PLANNER. HE WAS COMPLETELY DEVOTED TO HIS FAMILY AND IS PROCEEDED IN DEATH BY HIS BEAUTIFUL WIFE OF 58 YEARS, KAREEN. HE IS SURVIVED BY THEIR 6 CHILDREN, 13 GRANDCHILDREN, 5 GREAT GRANDCHILDREN, AND A WEALTH OF FAMILY AND FRIENDS WHO WILL MISS HIM DEARLY. ALSO WE ADJOURN IN MEMORY OF LUPE DOMINGUEZ, A RESIDENT OF DOWNEY SINCE 1960, WHO PASSED AWAY PEACEFULLY SURROUNDED BY LOVING FAMILY ON JUNE 1ST AT THE WONDERFUL AGE OF 106. SHE WAS BORN IN MEXICO, BUT IN 1915 AT THE AGE OF 5 MOVED WITH HER FAMILY TO CALIFORNIA, EVENTUALLY EARNING HER AMERICAN CITIZENSHIP, WHICH SHE WAS VERY PROUD OF. SHE HAD A ZEST FOR LIFE AND ENJOYED SPENDING TIME WITH FAMILY AND FRIENDS, LOVED GOING TO LAS VEGAS AND THE CASINOS, DANCING, AND JOINED HER DAUGHTER AND SON-IN-LAW IN TRIPS TO LAUGHLIN IN A CLASSIC '57 CHEVY. SHE WAS PRECEDED IN DEATH BY HER LOVING HUSBAND JOSE AND IS SURVIVED BY HER BEAUTIFUL DAUGHTERS MARY LOU AND JOANNE, IN ADDITION TO SIX GRANDCHILDREN, SIX GREAT-GRANDCHILDREN AND FOUR GREAT-GREATS. SHE WAS A VERY SPECIAL PERSON, POSITIVELY TOUCHED ALL WHO KNEW HER, AND SHE'LL BE DEARLY MISSED BY FAMILY AND FRIENDS. AND FINALLY THAT WE ADJOURN IN MEMORY OF LEVIN GUTIERREZ, A RESIDENT OF BELLFLOWER, WHO PASSED AWAY RECENTLY AT THE AGE OF 70. HE WAS AN INDUSTRIAL FURNITURE INSTALLER AND A VERY STRONG SUPPORTER AND RESCUER OF HOMELESS DOGS. HE IS SURVIVED BY HIS WIFE, MARIA, THEIR TWO DAUGHTERS, CLAUDIA AND COREA, TWO SONS, LEVIN AND ARIEL, AND THREE GRANDSONS AND ONE GRANDDAUGHTER. HE WILL BE TRULY MISSED BY FAMILY AND FRIENDS. THOSE ARE MY ADJOURNMENTS, MADAME CHAIR. 

HILDA SOLIS, CHAIR: THANK YOU. SUCH WILL BE THE ORDERS. SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: FIRST ADJOURNMENT IS BY SUPERVISOR MARK RIDLEY-THOMAS, AND I JOIN AS THE COAUTHOR TO ADJOURN TODAY IN THE MEMORY OF DR. VERNA DAUTERIVE, WHO WAS BORN IN 1922 IN FLORIDA, PASSED AWAY ON JUNE 1ST THIS YEAR AT THE AGE OF 93. HER MOTHER WAS THE PRINCIPAL OF AN AFRICAN-AMERICAN-ONLY SCHOOL, AND HER FATHER WAS A PULLMAN TRAIN PORTER. AFTER RECEIVING HER BACHELOR'S DEGREE FROM WILEY COLLEGE, AN HISTORICALLY BLACK COLLEGE IN TEXAS, SHE ENROLLED AT THE UNIVERSITY OF SOUTHERN CALIFORNIA, WHERE SHE EARNED HER MASTER'S DEGREE IN EDUCATION AND IN 1949 HER DOCTORATE DEGREE IN THE SAME FIELD, TAKING NIGHT AND WEEKEND CLASSES AS SHE WORKED AS A TEACHER. SHE MET HER FRIEND PETER AT U.S.C., WHERE THEY BOTH TOGETHER REMAINED AVID SUPPORTERS THROUGHOUT THEIR LIVES, COMMITTING $30 MILLION TO CREATE AND NAME THE FIRST INTERDISCIPLINARY SOCIAL SCIENCE BUILDING AT U.S.C. IN THEIR NAME. SHE WORKED FOR THE L.A. UNIFIED SCHOOL DISTRICT FOR SIX DECADES, INITIALLY AS A TEACHER, ADMINISTRATOR, AND PRINCIPAL AT FRANKLIN AVENUE ELEMENTARY SCHOOL, WHERE MY NIECES FIRST WENT IN LOS FELIZ, WHERE SHE SERVED THE COMMUNITY FOR 23 YEARS AND WAS WELL-RESPECTED. HER DOCTORAL DISSERTATION WAS AN HISTORICAL LEGAL STUDY OF INTEGRATION IN U.S. PUBLIC SCHOOLS, AND HER WORK IS STILL BEING USED AS A REFERENCE FOR LAW STUDENTS. SHE BECAME AN ADJUNCT PROFESSOR AT THE U.S.C. ROSSIER SCHOOL OF EDUCATION AND HELPED FUND EDUCARE, WHERE SHE LED THE DRIVE TO CREATE THE SCHOOL'S FIRST ENDOWED FACULTY POSITION AND WAS INSTRUMENTAL IN THE HIRING OF ALL U.S.C. ROSSIER'S DEANS SINCE 1973. SHE ALSO BELONGED TO THE SCHOOL'S ALUMNI AND SUPPORTS ASSOCIATION, THE BOARD OF COUNSELORS. IN 1995, SHE WAS HONORED WITH THE RECOGNITION OF OUTSTANDING SUPPORT FOR EDUCATION AWARD. SHE AND HER HUSBAND DEDICATED THEMSELVES TO HELPING MINORITY STUDENTS. IN 1975, SHE WAS ONE OF A SMALL GROUP OF ALUMNI WHO FORMED THE NUCLEUS OF WHAT IS NOW CALLED THE U.S.C. BLACK ALUMNI ASSOCIATION, AND IN 1985 THEY ENDOWED THE DR. VERNA DAUTERIVES AND PETER SCHOLARSHIP PROGRAM, THE UNIVERSITY'S FIRST SCHOLARSHIP FOR MINORITY DOCTORAL STUDENTS IN EDUCATION. IN 2013, SHE RECEIVED THE PRESIDENTIAL MEDALLION, U.S.C.'S TOP HONOR, AND SHE ALSO INFLUENCED EDUCATION POLICY IN CALIFORNIA. SHE SERVED WITH GOVERNOR DEUKMEJIAN'S ADMINISTRATION, CHAIRING THE STATE COMMISSION ON TEACHER CREDENTIALING AND PRESIDENT REAGAN'S, WHEN HE WAS GOVERNOR, ON THE COMMISSION OF THE STATUS OF WOMEN, WHERE SHE SERVED TWO TERMS. SHE WILL BE REMEMBERED AS AN INSPIRATIONAL INFLUENTIAL EDUCATOR, PHILANTHROPIST, AND SHE AND HER HUSBAND'S LIFELONG DEVOTION TO U.S.C. AND HER L.A. COUNTY COMMUNITY. SHE'S SURVIVED BY A HOST OF FAMILY, FRIENDS, COLLEAGUES, STUDENTS, MEMBERS OF THE TROJAN FAMILY, WHO WILL MISS HER DEARLY. BOTH SHE AND HER HUSBAND WITH QUITE ACTIVE IN REPUBLICAN PARTY ACTIVITIES, SERVING AS DELEGATES TO THE NATIONAL CONVENTIONS AND AT THE STATE COMMITTEE AND WORKING WITH PRESIDENT RONALD REAGAN AND PRESIDENT GERALD FORD, RICHARD NIXON, AND ALONG WITH PRESIDENT H.W. BUSH. AND SHE WAS A PERSONAL FRIEND AND SUPPORTER OF MY OWN, AND MISS HER AND HER LEADERSHIP. NEXT ONE IS A FRIEND THAT MANY OF YOU HAVE MET BEFORE WHEN HE LED THE BOARD IN PRAYER, AND THAT WAS MONSIGNOR FELIX DIOMARTICH, WHO WAS THE OLDEST PRIEST IN THE ARCHDIOCESE OF LOS ANGELES COUNTY, PASSED AWAY ON JUNE 7TH AT THE AGE OF 101. AND HE WAS HERE WHEN HE WAS 101 GIVING THAT PRAYER. HE HEARD THE CALLING OF THE PRIESTHOOD AS A YOUNG BOY IN CROATIA AND AFTER FINISHING THE THEOLOGICAL SEMINARY AT SPLIT AND FURTHER STUDIES AT THE UNIVERSITY OF ZAGREB, HE WAS ORDAINED IN 1937. FOR A YEAR, HE SERVED AS AN ASSISTANT PASTOR AND THEN APPOINTED SECRETARY TO HIS BISHOP. HE IMPRESSED HIS SUPERIOR SO MUCH THAT THEY SENT HIM OFF TO ROME TO EARN A DOCTORATE IN SACRED THEOLOGY AND CANON LAW AT THE PRESTIGIOUS GREGORIAN UNIVERSITY, SPENDING SEVEN YEARS IN THE ETERNAL CITY. IN 1947, HE WAS INVITED TO COME TO NEW YORK. IN 1950, HE CAME TO LOS ANGELES AND JOINED ST. ANTHONY CHURCH, WHERE HE STAYED UNTIL HIS RETIREMENT IN 2012. HE TOUCHED AND CHANGED THE LIVES OF SO MANY, INCLUDING MY OWN, AND HE WILL BE GREATLY MISSED. BUT AS HE ONCE SAID, "LIFE GOES ON AND WE OFTEN WORRY WHAT THE FUTURE WILL BE. LITTLE BY LITTLE YOU'RE PREPARED FOR WHAT HAPPENS, UNTIL YOU COME TO THE SUNSET YEARS. BUT BEHIND THAT IS THE SUNRISE." MONSIGNOR DIOMARTICH IS SURVIVED BY HIS TWO SISTERS, NEPHEW FELIX AND HIS NIECE MARYANN, AND HIS GOOD FRIEND NIKO BUMBAK. WHAT'S INTERESTING ABOUT MONSIGNOR DIOMARTICH, HE WAS IN ROME DURING WORLD WAR II. YOU MAY HAVE SEEN THE MOVIE "THE RED AND THE BLACK" THAT STARRED GREGORY PECK ABOUT THIS IRISH PRIEST THAT WAS HELPING THE FLYERS WHO WERE SHOT DOWN OVER ROME AND THE NAZIS WERE TRYING TO FIND THIS PRIEST. THEY COULD NEVER FIND HIM, BECAUSE HE WOULD WEAR DIFFERENT CLOTHES. HE'D DRESS AS A WOMAN. HE'D DRESS AS A LABORER, WHATEVER. AND HE WOULD SLIP OUT OF ROME AND HELP THE REFUGEES AND THE DOWNED FLYERS. WHAT HAPPENED, BECAUSE THE UNDERGROUND WAS KILLING SO MANY OF THE NAZIS, THE NAZIS WERE BLAMING THE JEWS AND THEY TOLD THE JEWISH COMMUNITY, RABBI ZOLLI, WHO WAS THE CHIEF RABBI OF ROME, THAT THEY HAD TO GIVE THEIR WEIGHT IN GOLD, OTHERWISE THEY WERE GOING TO LIQUIDATE THE ENTIRE COMMUNITY. SO, THEY WENT OUT AND THE JEWISH COMMUNITY COULD NOT COME UP WITH ENOUGH GOLD, SO THE POPE PROVIDED THE REST OF THE GOLD TO SAVE THE JEWISH COMMUNITY. AFTER THE WAR, THE NAZI COLONEL WAS COMMITTED TO LIFE IMPRISONMENT AS A WAR CRIMINAL. THAT IRISH PRIEST VISITED HIM EVERY WEEK OR EVERY MONTH UNTIL HE DIED, WHO LATER RENOUNCED HIS ATHEISM, AND BECAME A CATHOLIC CHRISTIAN. RABBI ZOLLI, AFTER THE WAR, THE CHIEF RABBI, HE AND HIS WIFE AND FAMILY WERE BAPTIZED BY THE POPE. FELIX WAS THERE KNOWING ALL THESE PEOPLE, OBSERVING ALL THIS HISTORY, AND LATER BECAME ACTIVE MEMBERS IN THE CATHOLIC FAITH. AND WHAT WAS INTERESTING, MONSIGNOR'S MEMORY WAS AS VIVID AND SHARP WHEN HE PASSED ON AS IT WAS AS A YOUNG MAN. I MEAN, HE WAS BLESSED WITH A GREAT MEMORY, AND HE WAS A GREAT INSPIRATION, ROLE MODEL. HE PARTICIPATED IN MY WEDDING, WHICH WAS AN INTERESTING WEDDING, BECAUSE WE HAD TWO ROMAN CATHOLIC PRIESTS FROM THE CROATIAN COMMUNITY, MONSIGNOR DIOMARTICH AND SEGARIC, A LUTHERAN PASTOR, PASTOR RIECK, AND THE ARCHBISHOP OF THE ARMENIAN CHURCH, ARCHBISHOP MARDIROSSIAN, AND MY AUNT, WHO WAS SISTER ST. GEORGE, WITH RED BUTTONS DOING THE OLD TESTAMENT AND PAT BOONE DOING THE NEW TESTAMENT AND WE HAD HIGH MASS IN THAT SERVICE. IT WAS A VERY BEAUTIFUL SERVICE. AND HIS FUNERAL WILL BE NEXT WEEK. HE WANTED IT TO BE AT ST. ANTHONY'S, WHICH IS UP THE STREET ON GRAND, WHICH IS BASICALLY THE MOTHER CHURCH, AND A WONDERFUL MAN. ALSO FRANK MATRANGA, WHO WAS A FRATERNITY BROTHER OF MINE, PASSED AWAY AT THE AGE OF 83. HE EARNED HIS BACHELOR'S DEGREE FROM CAL STATE AND MASTERS FROM U.S.C., TAUGHT SCHOOL, AND WAS A PROFESSOR AT HARBOR COLLEGE. HE MADE ABOUT 60 MURALS, INCLUDING 6 AT DIFFERENT LOS ANGELES COUNTY LIBRARIES. AND HE IS SURVIVED BY HIS WIFE. MARY LOU BANGER, WHO WAS ALSO ACTIVE IN THE CROATIAN COMMUNITY, PASSED AWAY AT THE AGE OF 88. SHE WORKED FOR L.A. COUNTY FOR 30 YEARS. SHE WAS THE EXECUTIVE SECRETARY TO SUPERVISOR HERBERT LEGG AND WARREN DORN AND ALSO SECRETARY TO THE EXECUTIVE OFFICER JIM MIES. SHE SERVED AS A GRAND JUROR ON THE L.A. COUNTY CRIMINAL GRAND JURY AND HAD BEEN ACTIVE BOARD MEMBER OF THE RETIRED EMPLOYEES OF LOS ANGELES, WHERE SHE WAS AN OFFICER. SHE IS SURVIVED BY HER DAUGHTER DIANE AND SON ROBERT AND THREE GRANDCHILDREN, THREE GREAT- GRANDCHILDREN. CARRIE BENNETT PASSED AWAY AT THE AGE OF 88 ON JUNE 6. SHE WAS A CHURCH LECTOR, EUCHARISTIC MINISTER, A LAY CARMELITE, AND WAS INVOLVED IN SEVERAL CATHOLIC CHARITIES. AND SHE IS SURVIVED BY HER DAUGHTER AND HER SEVEN GRANDCHILDREN. ROBERT EGELSTON PASSED AWAY ON MAY 9TH. HE WAS A GRADUATE AT WEST POINT MILITARY ACADEMY, SERVED IN THE UNITED STATES ARMY, RECEIVED HIS MASTER'S DEGREE FROM WHARTON SCHOOL OF THE UNIVERSITY OF PENNSYLVANIA, AND WORKED 40 YEARS AT THE CAPITAL GROUP, ACTIVE SUPPORTER OF THE COLBURN SCHOOL, COLBURN FOUNDATION, AND L.A. PHILHARMONIC, THE CLAREMONT GRADUATE UNIVERSITY, THE ART CENTER COLLEGE OF DESIGN, AND THE CALIFORNIA INSTITUTE OF THE ARTS. HE SERVED AS CHAIRMAN OF THE L.A. MUSIC CENTER, WHERE HE CHAMPIONED THE PROJECT TO BUILD THE WALT DISNEY CONCERT HALL. HE IS SURVIVED BY HIS WIFE AND DAUGHTERS, DIANE AND JANET. AND.. ISMAEL LOYA WITH THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. HE JOINED THE DEPARTMENT IN 1987, AND HIS LAST ASSIGNMENT WAS COURT SERVICES. AND HE PASSED AWAY ON MAY 28TH. MARJORIE ANNE MARCULESCU, LONGTIME RESIDENT OF SAN MARINO, ACTIVE WITH FIVE ACRES, HUNTINGTON HOSPITAL, PASADENA GUILD, MEMBER OF THE NATIONAL CHARITY LEAGUE AND THE SAN MARINO AREA AREA CHAPTER AND, SHE'S SURVIVED BY HER DAUGHTER. AND A GOOD FRIEND THAT SOME OF YOU MAY HAVE KNOWN -- I KNOW, SHEILA, YOU MAY HAVE KNOWN KIRK WEST, LONGTIME BUSINESS ADVOCATE IN SACRAMENTO, PASSED AWAY AT THE AGE OF 79. HE EARNED HIS BACHELOR'S DEGREE FROM STANFORD UNIVERSITY, HIS MASTER'S IN POLITICAL SCIENCE FROM BERKELEY. HE WORKED ON RONALD REAGAN'S BUDGET STAFF AND LATER BECAME CHIEF DEPUTY TO STATE CONTROLLER HOUSTON FLOURNOY, LATER SERVING AS THE CHIEF EXECUTIVE OF THE CALIFORNIA TAXPAYERS ASSOCIATION AND THEN THE CALIFORNIA CHAMBER OF COMMERCE AND SURVIVED BY HIS WIFE AND THREE CHILDREN, BUT A REAL QUALITY MAN. OKAY, ADD SHEILA KUEHL TO THAT MOTION. THANK YOU. THOSE ARE MY MOTIONS. 

HILDA SOLIS, CHAIR: WITHOUT OBJECTION. I HAVE SEVERAL ADJOURNMENTS, AS WELL. ONE THAT REALLY SADDENS ME IS I WANT TO MOVE THAT WE ADJOURN TODAY IN MEMORY OF HELEN CHAVEZ. I MET HELEN CHAVEZ, UNFORTUNATELY, BACK IN 1993 AT HER HUSBAND CESAR CHAVEZ'S FUNERAL IN DELANO. AND I SAW HER AGAIN SEVERAL TIMES THROUGHOUT MY POLITICAL CAREER, BUT ALSO MOST RECENTLY AT THE NAMING OF THE CESAR CHAVEZ LA PAZ NATIONAL MONUMENT BY PRESIDENT BARACK OBAMA. SHE WAS ALREADY NOT WELL AT THAT TIME. HELEN CHAVEZ, AS YOU MAY KNOW, WAS BORN ON JANUARY 21, 1928 IN BRAWLEY, CALIFORNIA. AT THE AGE OF 14, SHE BEGAN WORKING IN THE FIELDS IN ORDER TO HELP SUPPORT HER FAMILY. SHE MET CESAR CHAVEZ IN THE MID- 1940S WHILE THEY WERE BOTH WORKING AS LABORERS. THEY MARRIED BACK IN 1948 AFTER CESAR CHAVEZ'S DISCHARGE FROM THE NAVY AND HAD EIGHT CHILDREN. HELEN WAS NOT ONLY A WIFE AND MOTHER BUT ALSO HELPED ORGANIZE THE FARM WORKERS UNION AND PROVIDED FOR THE FAMILY. AT THE TIME, HELEN AND CESAR CHAVEZ MADE THE DECISION TO BEGIN THE UNITED FARM WORKERS, SHE WENT BACK INTO THE FIELDS TO WORK IN ORDER TO HELP THE FAMILY SURVIVE. WHEN THE DELANO GRAPE STRIKE STARTED BACK IN 1965, HELEN TOOK OVER THE MANAGEMENT OF THE UNITED FARM WORKERS CREDIT UNION AND WORKED FULL-TIME AT THE UNION OFFICE WHILE MAINTAINING A HOME FOR HER CHILDREN. SHE CONTINUED SERVING THE FARM WORKER MOVEMENT FOR DECADES. HELEN IS SURVIVED BY SEVEN OF HER CHILDREN, ELOISE CARRILLO, PAUL CHAVEZ, SYLVIA DELGADO, ANTHONY CHAVEZ, FERNANDO CHAVEZ, ANNA YBARRA, ELIZABETH VILLARINO, AND MANY GRANDCHILDREN AND GREAT-GRANDCHILDREN. NEXT, I'D LIKE TO MOVE TO ADJOURN IN MEMORY OF DESIDARIO CHAVEZ ROBLES. DESIDARIO CHAVEZ ROBLES WAS BORN ON SEPTEMBER 19, 1923 IN ZACATECAS, MEXICO, AND PASSED AWAY MAY 21ST, 2016 IN SANTA PAULA, CALIFORNIA. MR. ROBLES IMMIGRATED TO THE UNITED STATES IN 1957 AND SETTLED IN IN SANTA PAULA, CALIFORNIA, A FEW YEARS LATER. IN 1943, AT JUST 20 YEARS OF AGE, HE MARRIED GUADALUPE ROBLES, AND WAS A FATHER TO 11 CHILDREN. MR. AND MRS. ROBLES SHARED 72 YEARS TOGETHER UNTIL HIS PASSING. HE WAS A MAN OF SIMPLE PLEASURES. HIS FAVORITE ACTIVITIES INCLUDED HIS BREAKFAST OF COFFEE AND PAN DULCE WHILE READING THE NEWSPAPER, SITTING ON THE PORCH READING WESTERN NOVELS, AND AN EVENING COFFEE WITH HIS WIFE AFTER DINNER. HE LEFT TO GO BACK TO HIS HOME IN SAN MIGUEL, ZACATECAS, AND WORK ON HIS LAND. MR. ROBLES WAS A SKILLED FARMER, CARPENTER, MASON, BAKER, AND ATHLETE. BOTH IN SAN MIGUEL AND IN HIS COMMUNITY IN SANTA PAULA, HE WAS WELL-KNOWN FOR THESE SKILLS, BEST KNOWN FOR HIS SENSE OF HUMOR AND WILLINGNESS TO HELP OTHERS. MR. ROBLES IS SURVIVED BY HIS WIFE, GUADALUPE, SONS, ROQUE, JUAN, CATARINO, AND MIGUEL, DAUGHTERS, JUAQUINA, MARICELA, ANGELA, AND MARTHA, AND HIS MANY GRANDCHILDREN. AND LASTLY, IT IS WITH GREAT SADNESS THAT WE MOVE TO ADJOURN IN MEMORY OF BOLOGI PAMOYAWA, HEAD BOARD SPECIALIST, EXECUTIVE OFFICE OF THE BOARD OF SUPERVISORS, WHO PASSED AWAY SUDDENLY EARLY MORNING ON SUNDAY, JUNE THE 5TH. BOLOGI STARTED HER CAREER WITH THE COUNTY OF LOS ANGELES IN AUGUST OF 1996. SHE WAS A FAITHFUL PUBLIC SERVANT FOR OVER 20 YEARS, WORKING WITH THE DEPARTMENT OF HEALTH SERVICES, SUPERIOR COURT, THE FIRE DEPARTMENT, BEFORE JOINING THE EXECUTIVE OFFICE IN 2012. SHE WAS A PREACHER OF GOSPEL WHO INSPIRED AND TOUCHED MANY LIVES. OUR PRAYERS ARE WITH HER TWO BEAUTIFUL DAUGHTERS, SAGE, BUMI, AND PUMAYAWA, HER MOTHER AND SISTERS AND BROTHERS. THAT'S ALL THAT I HAVE. ALL MEMBERS, WITHOUT OBJECTION. SUPERVISOR KUEHL? 

SUP. SHEILA KUEHL: I WASN'T CERTAIN WHETHER SUPERVISOR RIDLEY-THOMAS WAS GOING TO ASK FOR THIS ADJOURNMENT, BUT I'D LIKE TO MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN HONOR OF MUHAMMAD ALI. HE WAS, WELL, WE COULD SAY CASSIUS CLAY. HE CHANGED HIS NAME, BUT WHEN WE KNEW HIM BACK IN THE EARLY '60S IN THE CRENSHAW DISTRICT, HE WAS WORKING OUT AT GOLD'S GYM DOWN KIND OF BY 54TH STREET AND CRENSHAW, WAS PART OF THE -- I'M NOT CLAIMING TO HAVE KNOWN HIM, BUT HE WAS KIND OF A LEGEND AND GOT TO BE A REALLY BIG LEGEND IN L.A. I KNOW THAT HE LIVED IN L.A. A GREAT PART OF HIS LIFE, OR SOME PART OF THE YEAR EVERY YEAR IN L.A. I THINK WE'VE ALL READ A GOOD DEAL ABOUT WHAT HE DID AND WHAT A HERO HE WAS TO PEOPLE, MUCH MORE THAN A GREAT ATHLETE. AND WHETHER YOU AGREED WITH HIM AS HE WENT ALONG OR NOT, YOU HAD TO ADMIRE HIS COURAGE AND HIS VALUES. AND SO I WOULD MOVE THAT WE ADJOURN IN HIS MEMORY. 

HILDA SOLIS, CHAIR: I WOULD JUST, FOR ALL MEMBERS, I WOULD JUST LIKE TO SAY THAT I WAS PERSONALLY TOUCHED DURING THE WEEKEND TO SEE ALL THE MANY CONTRIBUTIONS THAT HE MADE, AN OUTSTANDING INDIVIDUAL THAT STOOD FOR HIS VALUES AND HIS RIGHTS. AND WHETHER WE BELIEVE IN WHAT HE THOUGHT WAS TRUE OR NOT, HE'S A GREAT MAN, AND HE'LL GO DOWN IN HISTORY FOR SO MANY PEOPLE THAT ARE STILL CONTEMPLATING SOME OF THE ISSUES THAT HE RAISED: WAR, THE FACT THAT HE HAD A DIFFERENT RELIGION, AND THAT HIS CONVICTIONS WERE SO STRONG, A MAN OF HONOR. SO I, TOO, WANT TO SHARE MY THOUGHTS WITH HIS FAMILY AND WITH THOSE YOUNGSTERS THAT ARE WATCHING TO SEE WHAT TRUE LEADERS ARE MADE OF. THANK YOU. THANK YOU, SHEILA. OKAY. WE NOW HAVE.. PUBLIC COMMENT. AND WE HAVE ARNOLD SACHS AND ERIC PREVEN. 

ERIC PREVEN: GREETINGS. IT IS ERIC PREVEN FROM THE THIRD DISTRICT. AND I HAVE A GREAT IDEA, FUNDING IDEA FOR THE BOARD OF SUPERVISORS, SUPERVISOR KUEHL OBVIOUSLY A GREAT LEADER, THIRD DISTRICT, AND MARK RIDLEY-THOMAS FROM THE SECOND DISTRICT MIGHT FIND THIS APPEALING. SO, DOWNTOWN HERE IN LOS ANGELES WE HAVE 700, PLUS OR MINUS, PUBLIC DEFENDERS. WE HAVE ABOUT A THOUSAND DISTRICT ATTORNEYS. THAT'S JUST THE LAWYER PART OF THE DISTRICT ATTORNEY. THERE'S ANOTHER THOUSAND WHO WORK THERE. I THINK COUNTY COUNSEL HAS OVER 500, AND THERE'S ABOUT 300 OR SO ATTORNEYS. CITY ATTORNEY HAS 900, BELIEVE IT OR NOT, AND ABOUT 600 OF THEM ARE ATTORNEYS. SO, THAT IS AN AWFUL LOT OF GREAT ATTORNEYS WORKING IN PUBLIC SERVICE. I THINK IT'S FANTASTIC, AND THEY ARE DOING VARIOUS JOBS. I THINK YOU KNOW THEY ARE ALL A LITTLE DIFFERENT. WHAT IS ABSENT DOWNTOWN IS AN AGENCY OR A GROUP. THERE IS THE PUBLIC INTEGRITY DIVISION, BUT I THINK WE SHOULD LEAVE THEM OUT FOR A MINUTE, BECAUSE THEY'RE ONLY CONCERNED WITH PROSECUTING VIOLATIONS OF THE LAW. BUT I THINK A LITTLE PUBLIC ADVOCACY LAW OFFICE, LIKE PUBLIC COUNSEL. PUBLIC COUNSEL DOES NOT DEAL WITH COUNTY COURT. THEY DEAL ONLY WITH THE FEDERAL COURT. YOU'VE GOT YOUR NEIGHBORHOOD LEGAL SERVICES GROUP. YOU'VE GOT YOUR BET TZEDEK-- THEY DON'T DEAL WITH BROWN ACT STUFF. AND CUTTING TO THE CHASE QUICKLY, I THINK THAT THERE ARE SOME LAWS THAT WE ALL REVERE AND TRY TO INTERPRET OUR VARIOUS WAYS. WE DON'T ALWAYS AGREE ABOUT THE BROWN ACT, I THINK, OR THE PUBLIC RECORD ACT, BUT THAT'S THE NATURE OF THE BEAST. BUT THE SYSTEM IS THAT A JUDGE IS SUPPOSED TO MAKE A DECISION ON THESE THINGS, AND THE FOLKS LIKE SACHS AND MYSELF AND OTHERS WHO DISAGREE, THERE'S NO LAWYER WHO IS GOIGN TO HELP US WRITE UP THE DISCUSSION SO THAT A JUDGE CAN HAVE A CLEAR LOOK. IN FACT, JUDGES, WHEN THEY DEAL WITH SOMEONE LIKE ME WHO HAS TO DO IT ON HIS OWN, GET ANNOYED, BECAUSE YOU GOT CONFUSING PLEADINGS BY INEXPERT CHARACTERS. SO, WE'RE NOT LOOKING FOR SOMEONE TO DO MUCH MORE THAN HELP PROCESS THESE ISSUES, BECAUSE, LOOK, IF WE DISAGREE ABOUT SOMETHING AND YOUR -- A JUDGE SAYS, "YOU'RE WRONG," AND THAT'S IT, I THINK PEOPLE TEND TO BELIEVE THAT, OR THEY APPEAL, LIKE ME. BUT THAT'S NOT MY POINT. MY POINT IS IS THAT WE NEED AN OFFICE TO HELP WITH THAT WORK. THANK YOU. 

HILDA SOLIS, CHAIR: NEXT SPEAKER. 

ARNOLD SACHS: IT IS AFTERNOON. ARNOLD SACHS. AND BECAUSE OF YOUR SITUATION WHERE YOU ONLY ALLOW US THE THREE MINUTES TO DISCUSS ITEMS ON YOUR AGENDA, WHICH IS SO VERY DEMOCRATIC, ONE OF THE THINGS, AS YOU MENTIONED, ABOUT MUHAMMAD ALI WAS HIS CONVICTIONS THAT HE STOOD FOR, WHICH IS QUITE THE ANTITHESIS OF WHAT YOU STAND FOR AS FAR AS YOUR CONVICTIONS AND ALLOWING INPUT ON PUBLIC COMMENT, OR PUBLIC, NOT PUBLIC COMMENT, PUBLIC DISCUSSION ON ITEMS ON YOUR AGENDA. COUNTY COUNSEL WOULD HAVE YOU SAY THAT YOU'RE OFF THE SUBJECT, BUT THIS BEING PUBLIC COMMENT, I'M NOT REALLY OFF THE SUBJECT. NOTHING ABOUT PORTER RANCH, ALTHOUGH ON YOUR ITEMS TODAY, YOU MOVED TO HAVE EXIDE AND MOVED AS A DISCUSSION, AN A-LIST ITEM THAT WILL BE BROUGHT BEFORE THE BOARD ON OCCASION FOR UPDATES AND DISCUSSIONS. FORTUNATELY, YOU WAITED UNTIL AFTER THEY HAD A SETTLEMENT WITH THE FEDERAL GOVERNMENT, WHERE NOBODY WILL BE FACING ANY CONVICTIONS FOR ANY OF THE 30 YEARS OR 40 YEARS OF POLLUTIONS OF THE GROUND THAT OCCURRED WHILE THEY WERE IN OPERATIONS. I MEAN, THAT'S, AS MR. PREVEN WOULD SAY, KUDOS TO THE BOARD OF SUPERVISORS. BUT A LITTLE BIT ABOUT THE PORTER RANCH. WE DIDN'T HEAR ANYTHING. WHY THAT ITEM HAS BEEN MOVED FROM A DISCUSSION ITEM TO CLOSED SESSION, I HAVE A THEORY ABOUT THAT. BUT AGAIN, BACK TO THE HOMEOWNERS' ASSOCIATION, AND THE STANDING, AND THIS ITEM, AGAIN, I WOULD REITERATE TO THE PEOPLE IN PORTER RANCH, IT'S FROM 1/8/14 FROM "THE METROPOLITAN NEWS". THIS IS AN AGREEMENT WAS MADE BETWEEN THE DEVELOPERS BEFORE THERE WAS ANY HOME BUILT AND THE HOMEOWNERS ASSOCIATION HAD STANDING. 

HILDA SOLIS, CHAIR: TIME'S EXPIRED. AT THIS TIME, THE EXECUTIVE OFFICER WILL READ US INTO EXECUTIVE SESSION. 

LORI GLASGOW, EXEC. OFCR.: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEMS NO. C.S.-1 AND C.S.-2, CONFERENCES WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION; ITEM NO. C.S.-3, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION; AND ITEM C.S.-4, DEPARTMENT HEAD PERFORMANCE EVALUATIONS, AS INDICATED ON THE POSTED AGENDA. 

HILDA SOLIS, CHAIR: THIS MEETING IS NOW ADJOURNED TO EXECUTIVE SESSION. 
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